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Product Overview

¢ “Introduction” on page 1-2
¢ “Installation” on page 1-3
* “Demos” on page 1-4

¢ “Using the Documentation” on page 1-5
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Introduction

MATLAB® technical computing software has a rich collection of functions
immediately useful to the control engineer or system theorist. Complex
arithmetic, eigenvalues, root-finding, matrix inversion, and fast Fourier
transforms are just a few examples of important numerical tools found in
MATLAB. More generally, the MATLAB linear algebra, matrix computation,
and numerical analysis capabilities provide a reliable foundation for control
system engineering as well as many other disciplines.

The Control System Toolbox™ product builds on the foundations of the
MATLAB software to provide functions designed for control engineering.
This product is a collection of algorithms, written mostly as M-files,
that implements common control system design, analysis, and modeling
techniques. Convenient graphical user interfaces (GUIs) simplify typical
control engineering tasks.

Control systems can be modeled as transfer functions, in zero-pole-gain or
state-space form, allowing you to use both classical and modern control
techniques. You can manipulate both continuous-time and discrete-time
systems. Conversions between various model representations are provided.
Time responses, frequency responses, and root loci can be computed and
graphed. Other functions allow pole placement, optimal control, and
estimation. Finally, this product is open and extensible. You can create
custom M-files to suit your particular application.



Installation

Installation

Instructions for installing the Control System Toolbox software can be found
in the MATLAB Installation documentation for your platform. For best
results, store the files from this toolbox in a subdirectory named control
under the main matlab directory. To determine if the software is already
installed on your system, check for a subdirectory named control within
the main toolbox directory or folder.
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Demos

Control System Toolbox demonstration files show you how to use the toolbox
to perform control design tasks in various settings. To run these demos, type

demo toolbox control

at the MATLAB prompt. This opens the Demos pane in the Help browser
showing the Control System Toolbox demos. Alternatively, if you have the
Help browser open, you can select the Demos pane directly and follow the
same procedure.

In addition, Design Case Studies contains detailed examples of various design
problems.

1-4
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Using the Documentation

If you are a new user, this guide, the Conitrol System Toolbox Getting
Started Guide, is written for you. Specifically, you will learn

¢ How to build and manipulate linear time-invariant models of dynamical
systems

¢ How to analyze such models and plot their time and frequency responses

* How to design compensators using root locus and pole placement techniques

In addition, this guide discusses model order reduction, linear quadratic
Gaussian (LQG) techniques, and presents examples that show how to use
these techniques.

This guide is available online. The rest of the toolbox documentation is
also available online; click the Control System Toolbox link to open its
product page, which is a roadmap with links to the Control System Toolbox
documentation and to PDF versions of the same documentation.

If you are an experienced toolbox user, see the following documentation
for detailed discussions of control system design topics:

® Release Notes — Details on the latest release

¢ Creating and Manipulating Models — In-depth information on how to
create and manipulate linear models and linear time-invariant (LTI)
arrays, which are data objects that you can use to store collections of linear
models in one variable

¢ Customization — Information about setting plot properties, including how
to set preferences that persist from session to session

® Control System Toolbox Design Case Studies— Worked examples, including
Kalman filtering and MIMO design

e Control System Toolbox Reliable Computations — Numerical stability and
accuracy issues

¢ Using the SISO Design Tool and the LTI Viewer — Complete descriptions
of the LTI Viewer and SISO Design Tool, which are graphical user
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interfaces (GUIs) that you can use to analyze systems and design
single-input/single-output (SISO) compensators

All toolbox users should use Functions - By Category for reference
information on functions and tools. For functions, reference descriptions
include a synopsis of the function’s syntax, as well as a complete explanation
of options and operation. Many reference descriptions also include helpful
examples, a description of the function’s algorithm, and references to
additional reading material. For GUI-based tools, the descriptions include
options for invoking the tool.



Building Models

¢ “Linear (LTI) Models” on page 2-2

e “MIMO Models” on page 2-13

® “Arrays of Linear Models” on page 2-18

e “Model Characteristics” on page 2-21

¢ “Interconnecting Linear Models” on page 2-23

¢ “Converting Between Continuous- and Discrete- Time Systems” on page
2-26

¢ “Reducing Model Order” on page 2-29
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Linear (LTl) Models

In this section...

“What Is a Plant?” on page 2-2

“Linear Model Representations” on page 2-2
“SISO Example: The DC Motor” on page 2-3
“Building SISO Models” on page 2-6
“Constructing Discrete Time Systems” on page 2-9
“Adding Delays to Linear Models” on page 2-10
“LTI Objects” on page 2-10

What Is a Plant?

Typically, control engineers begin by developing a mathematical description of
the dynamic system that they want to control. The system to be controlled is
called a plant. As an example of a plant, this section uses the DC motor. This
section develops the differential equations that describe the electromechanical
properties of a DC motor with an inertial load. It then shows you how to

use the Control System Toolbox functions to build linear models based on
these equations.

Linear Model Representations

You can use Control System Toolbox functions to create the following model
representations:

® State-space models (SS) of the form

@=Ax+Bu
dt
y=Cx+Du

where A, B, C, and D are matrices of appropriate dimensions, x is the state
vector, and u and y are the input and output vectors.

¢ Transfer functions (TF), for example,
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® Zero-pole-gain (ZPK) models, for example,

(z+1+ )(z+1-))

H(z)=3
(z+0.2)(z+0.1)

¢ Frequency response data (FRD) models, which consist of sampled
measurements of a system’s frequency response. For example, you can
store experimentally collected frequency response data in an FRD model.

Note The design of FRD models is a specialized subject that this guide does
not address. See Frequency Response Data (FRD) Models for a discussion
of this topic.

SISO Example: The DC Motor

A simple model of a DC motor driving an inertial load shows the angular rate

of the load, w(¢), as the output and applied voltage, Uapp(t) , as the input. The
ultimate goal of this example is to control the angular rate by varying the
applied voltage. This figure shows a simple model of the DC motor.

ift) R
.
o— VN
+ Kyuo(£)
Viscous
Vappl?) b friction
DC Motor 1::":‘?
a
o
T(1)
Torque wyr)
Angulor rote

A Simple Model of a DC Motor Driving an Inertial Load
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In this model, the dynamics of the motor itself are idealized; for instance,
the magnetic field is assumed to be constant. The resistance of the circuit

is denoted by R and the self-inductance of the armature by L. If you are
unfamiliar with the basics of DC motor modeling, consult any basic text on
physical modeling. With this simple model and basic laws of physics, it is
possible to develop differential equations that describe the behavior of this
electromechanical system. In this example, the relationships between electric
potential and mechanical force are Faraday’s law of induction and Ampeére’s
law for the force on a conductor moving through a magnetic field.

Mathematical Derivation

The torque 1T seen at the shaft of the motor is proportional to the current i
induced by the applied voltage,

() = K,,,i(¢)
where K _, the armature constant, is related to physical properties of the
motor, such as magnetic field strength, the number of turns of wire around

the conductor coil, and so on. The back (induced) electromotive force, Vepnf » 18
a voltage proportional to the angular rate ® seen at the shaft,

Uemf @)= Kb(,l)(t)

where K,, the emf constant, also depends on certain physical properties
of the motor.

The mechanical part of the motor equations is derived using Newton’s law,
which states that the inertial load </ times the derivative of angular rate
equals the sum of all the torques about the motor shaft. The result is this
equation,

dw .
J% = Z‘L‘i = —Kf(D(t)+ Kml(t)
where Ko is a linear approximation for viscous friction.

Finally, the electrical part of the motor equations can be described by
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di .
Vapp @) = Vo (&) = L d—; +Ri(t)

or, solving for the applied voltage and substituting for the back emf,

Vapp® = L % + Rit) + Kpolt)

This sequence of equations leads to a set of two differential equations that
describe the behavior of the motor, the first for the induced current,

di  R.. K, 1
a = _fl(t)_T(D(t)-i_ZUapp(t)

and the second for the resulting angular rate,

do 1 1
2 S Ko+ =K, it

State-Space Equations for the DC Motor

Given the two differential equations derived in the last section, you can now
develop a state-space representation of the DC motor as a dynamic system.
The current i and the angular rate ® are the two states of the system. The

applied voltage, v, , 1s the input to the system, and the angular velocity
o is the output.

R K,
alil |7z "z |11 |&
_ — . . t
il K, K M”& Parr®
J J

y6=[0 1] m +[0]-0gpp )

State-Space Representation of the DC Motor Example

2-5



2 Building Models

Building SISO Models

After you develop a set of differential equations that describe your plant, you
can construct SISO models using simple commands. The following sections
discuss

¢ Constructing a state-space model of the DC motor

® Converting between model representations

¢ (Creating transfer function and zero/pole/gain models

Constructing a State-Space Model of the DC Motor
Enter the following nominal values for the various parameters of a DC motor.

-
1l
I onN

% torque constant
% emf constant

C X X
N = T
o o
o O
N
o°
~
«
3
>
N

Given these values, you can construct the numerical state-space
representation using the ss function.

[-R/L -Kb/L; Km/J -Kf/J]
= [1/L; 0O];

[0 1];

[0];

sys_dc = ss(A,B,C,D)

OO w >
|

These commands return the following result:

a:
x1 X2
x1 -4 -0.03
X2 0.75 -10
b =
ui

2-6
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X1 2
X2 0
C =
X1 X2
y1 0 1
d =
ui
y1

Converting Between Model Representations

Now that you have a state-space representation of the DC motor, you can
convert to other model representations, including transfer function (TF) and
zero/pole/gain (ZPK) models.

Transfer Function Representation. You can use tf to convert from the
state-space representation to the transfer function. For example, use this code
to convert to the transfer function representation of the DC motor.

sys_tf = tf(sys_dc)

Transfer function:
1.5

s"2 + 14 s + 40.02

Zero/Pole/Gain Representation. Similarly, the zpk function converts

from state-space or transfer function representations to the zero/pole/gain
format. Use this code to convert from the state-space representation to the
zero/pole/gain form for the DC motor.

sys_zpk = zpk(sys_dc)

Zero/pole/gain:
1.5

2-7
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(s+4.004) (s+9.996)

Note The state-space representation is best suited for numerical
computations. For highest accuracy, convert to state space prior to combining
models and avoid the transfer function and zero/pole/gain representations,
except for model specification and inspection. See Reliable Computations for
more information on numerical issues.

Constructing Transfer Function and Zero/Pole/Gain Models

In the DC motor example, the state-space approach produces a set of matrices
that represents the model. If you choose a different approach, you can
construct the corresponding models using tf, zpk, ss, or frd.

sys = tf(num,den) % Transfer function

sys = zpk(z,p,k) % Zero/pole/gain

sys = ss(a,b,c,d) % State-space

sys = frd(response,frequencies) % Frequency response data

For example, you can create the transfer function by specifying the numerator
and denominator with this code.

sys_tf = tf(1.5,[1 14 40.02])

Transfer function:
1.5

s"2 + 14 s + 40.02

Alternatively, if you want to create the transfer function of the DC motor
directly, use these commands.

s = tf('s");
sys_tf = 1.5/(s"2+14*s+40.02)

These commands result in this transfer function.

Transfer function:
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s"2 + 14 s + 40.02

To build the zero/pole/gain model, use this command.

sys_zpk = zpk([],[-9.996 -4.004], 1.5)

This command returns the following zero/pole/gain representation.

Zero/pole/gain:
1.5

(s+9.996) (s+4.004)

Constructing Discrete Time Systems

The Control System Toolbox software provides full support for discrete-time
systems. You can create discrete systems in the same way that you create
analog systems; the only difference is that you must specify a sample time
period for any model you build. For example,

sys_disc = tf(1, [1 1], .01);
creates a SISO model in the transfer function format.

Transfer function:

Sampling time: 0.01

Adding Time Delays to Discrete-Time Models

You can add time delays to discrete-time models by specifying an input
or output time delay when building the model. The time delay must be a
nonnegative integer that represents a multiple of the sampling time. For
example,

sys_delay = tf(1, [1 1], 0.01,'outputdelay',5);
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returns a system with an output delay of 0.05 second.

Transfer function:

Sampling time: 0.01

Adding Delays to Linear Models

You can add time delays to linear models by specifying an input or output
delay when building a model. For example, to add an input delay to the DC
motor, use this code.

sys_tfdelay = tf(1.5, [1 14 40.02], 'inputdelay',0.05)

This command constructs the DC motor transfer function, but adds a 0.05
second delay.

Transfer function:

exp(-0.05*s) * ------------o-----
s"2 + 14 s + 40.02

For a complete description of adding time delays to models and closing loops
with time delays, see Time Delays.

LTI Objects

For convenience, the Control System Toolbox software uses custom data
structures called LTI objects to store model-related data. For example, the
variable sys_dc created for the DC motor example is called an SS object.
There are also TF, ZPK, and FRD objects for transfer function, zero/pole/gain,
and frequency data response models respectively. The four LTI objects
encapsulate the model data and enable you to manipulate linear systems as
single entities rather than as collections of vectors or matrices.

To see what L'TT objects contain, use the get command. This code describes
the contents of sys_dc from the DC motor example.
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get(sys_dc)
[2x2 double]
[2x1 double]
[0 1]
: 0
[]
StateName: {2x1 cell}
InternalDelay: [Ox1 double]
Ts: O
InputDelay: O
OutputDelay: 0
InputName: {''}
OutputName: {''}
InputGroup: [1x1 struct]
OutputGroup: [1x1 struct]
Name: "'
Notes: {}
UserData: []

® O O T o

You can manipulate the data contained in LTI objects using the set command;
see the Control System Toolbox online reference pages for descriptions of
set and get.

Another convenient way to set or retrieve LTI model properties is to access
them directly using dot notation. For example, if you want to access the value
of the A matrix, instead of using get, you can type

sys_dc.a
at the MATLAB prompt. This notation returns the A matrix.
ans =

-4.0000 -0.0300
0.7500 -10.0000

Similarly, if you want to change the values of the A matrix, you can do so
directly, as this code shows.

A new = [-4.5 -0.05; 0.8 -12.0];

2-11
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sys_dc.a = A _new;
For more information on LTI properties, type 1tiprops at the MATLAB

prompt. For a complete description of LTI objects, see Creating and
Manipulating Models.
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MIMO Models

In this section...
“MIMO Example: State-Space Model of Jet Transport Aircraft” on page 2-13

“Constructing MIMO Transfer Functions” on page 2-15

“Accessing I/0 Pairs in MIMO Systems” on page 2-17

MIMO Example: State-Space Model of Jet Transport
Aircraft

You can use the same functions that apply to SISO systems to create
multiple-input, multiple-output (MIMO) models. This example shows how
to build a MIMO model of a jet transport. Because the development of a
physical model for a jet aircraft is lengthy, only the state-space equations
are presented here. See any standard text in aviation for a more complete
discussion of the physics behind aircraft flight.

The jet model during cruise flight at MACH = 0.8 and H = 40,000 ft. is

A = [-0.0558 -0.9968  0.0802 0.0415
0.5980 -0.1150 -0.0318 0
-3.0500  0.3880 -0.4650 0
0  0.0805 1.0000 01;
B =1 0.0073 0
-0.4750  0.0077
0.1530  0.1430
0 01;
C =10 1 0
0 0 0 11;
D= [0 0
0 0];

Use the following commands to specify this state-space model as an LTI object
and attach names to the states, inputs, and outputs.

2-13
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states = {'beta' 'yaw' 'roll' 'phi'};
inputs = {'rudder' 'aileron'};
outputs = {'yaw rate' 'bank angle'};

sys_mimo = ss(A,B,C,D, 'statename’',states,...
"inputname’',inputs, ...
"outputname’',outputs);

You can display the LTI model by typing sys_mimo.

sys_mimo
a:
beta yaw roll phi
beta -0.0558 -0.9968 0.0802 0.0415
yaw 0.598 -0.115 -0.0318 0
roll -3.05 0.388 -0.465 0
phi 0 0.0805 1 0
b =
rudder aileron
beta 0.0073 0
yaw -0.475 0.0077
roll 0.153 0.143
phi 0 0
C:
beta yaw roll phi
yaw rate 0 1 0 0
bank angle 0 0 0 1
d =
rudder aileron
yaw rate 0 0
bank angle 0 0

Continuous-time model.

2-14
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The model has two inputs and two outputs. The units are radians for beta
(sideslip angle) and phi (bank angle) and radians/sec for yaw (yaw rate) and
roll (roll rate). The rudder and aileron deflections are in degrees.

As in the SISO case, use tf to derive the transfer function representation.

tf (sys_mimo)

Transfer function from input "rudder" to output...

-0.475 s"3 - 0.2479 s*2 - 0.1187 s - 0.05633
yaw rate: ---------ioo--ii i

s"4 + 0.6358 s"3 + 0.9389 s"2 + 0.5116 s + 0.003674

0.1148 s*2 - 0.2004 s - 1.373
bank angle: --------ccciicei it e e et eee e

s"4 + 0.6358 s"3 + 0.9389 s"2 + 0.5116 s + 0.003674

Transfer function from input "aileron" to output...

0.0077 s"3 - 0.0005372 s"2 + 0.008688 s + 0.004523
yaw rate: ---------omoooi e

s"4 + 0.6358 s"3 + 0.9389 s*2 + 0.5116 s + 0.003674

0.1436 s"2 + 0.02737 s + 0.1104
bank angle: --------cccnicei ittt e et ee e

s"4 + 0.6358 s"3 + 0.9389 s"2 + 0.5116 s + 0.003674

Constructing MIMO Transfer Functions

MIMO transfer functions are two-dimensional arrays of elementary SISO

transfer functions. There are two ways to specify MIMO transfer function
models:

e (Concatenation of SISO transfer function models

e Using tf with cell array arguments

Concatenation of SISO Models
Consider the following single-input, two-output transfer function.
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s—1
s+1
s+2

H(s) =

s +4s+5

You can specify H(s) by concatenation of its SISO entries. For instance,

h11 = tF([1 -1],[1 11);
h21 = tf([1 2],[1 4 5]);

or, equivalently,

s = tf('s")
h11 = (s-1)/(s+1);
h21 = (s+2)/(s"2+4*s+5);

can be concatenated to form H(s).
H = [h11; h21]

This syntax mimics standard matrix concatenation and tends to be easier
and more readable for MIMO systems with many inputs and/or outputs. See
Model Interconnection Functions for more details on concatenation operations
for LTI systems.

Using the tf Function with Cell Arrays

Alternatively, to define MIMO transfer functions using tf, you need two cell
arrays (say, N and D) to represent the sets of numerator and denominator
polynomials, respectively. See Cell Arrays in the MATLAB documentation for
more details on cell arrays.

For example, for the rational transfer matrix H(s), the two cell arrays N and
D should contain the row-vector representations of the polynomial entries of

s—1 s+1
N(s) = [s - 2] Dis) = [2—}

s“+4s+5




MIMO Models

You can specify this MIMO transfer matrix H(s) by typing

N ={[1 -1];[1 21}; % Cell array for N(s)
D= {[1 1]1;[1 4 5]}; % Cell array for D(s)
H = tf(N,D)

These commands return the following result:

Transfer function from input to output...

s - 1
#1: -----
s + 1
s + 2
H2r oo .-

Notice that both N and D have the same dimensions as H. For a general MIMO

transfer matrix H(s), the cell array entries N{i,j} and D{i, j} should be

row-vector representations of the numerator and denominator of H;;(s), the

ijth entry of the transfer matrix H(s).

Accessing 1/0 Pairs in MIMO Systems

After you define a MIMO system, you can access and manipulate I/O pairs by
specifying input and output pairs of the system. For instance, if sys_mimo is a
MIMO system with two inputs and three outputs,

sys_mimo(3,1)

extracts the subsystem, mapping the first input to the third output. Row
indices select the outputs and column indices select the inputs. Similarly,

sys_mimo(3,1) = tf(1,[1 0])

redefines the transfer function between the first input and third output as
an integrator.
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Arrays of Linear Models

You can specify and manipulate collections of linear models as single entities
using LTI arrays. For example, if you want to vary the Kb and Km parameters
for the DC motor and store the resulting state-space models, use this code.

K =1[0.1 0.15 0.2]; % Several values for Km and Kb

A1 = [-R/L -K(1)/L; K(1)/J -Kf/J];
A2 = [-R/L -K(2)/L; K(2)/J -Kf/J];
A3 = [-R/L -K(3)/L; K(3)/J -Kf/JI;

sys_1lti(:,:,1)= ss(A1,B,C,D);
sys_1lti(:,:,2)= ss(A2,B,C,D);
sys_1lti(:,:,3)= ss(A3,B,C,D);

The number of inputs and outputs must be the same for all linear models
encapsulated by the LTI array, but the model order (number of states) can
vary from model to model within a single LTI array.

The LTI array sys_1ti contains the state-space models for each value of K.
Type sys_1ti to see the contents of the LTI array.

Model sys 1ti(:,:,1,1)

a:
X1 X2
x1 -4 -0.2
X2 5 -10

Model sys_1lti(:,:,2,1)

a:
X1 X2
x1 -4 -0.3
X2 7.5 -10



Arrays of Linear Models

Model sys 1ti(:,:,3,1)

a:
X1 X2
X1 -4 -0.4
X2 10 -10

éx1 array of continuous-time state-space models.

You can manipulate the LTI array like any other object. For example,
step(sys_1ti)

produces a plot containing step responses for all three state-space models.

rgwes -ioix

File Edit Wiew Insert Tools Desktop Window Help
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O ... E

Amplitude:

0z B

015 B

01+ B

00s B

Time (zec)

Step Responses for an LTl Array Containing Three Models
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LTT arrays are useful for performing batch analysis on an entire set of models.
For more information, see Arrays of LTI Models.
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Model Characteristics

You can use the Control System Toolbox commands to query model
characteristics such as the I/O dimensions, poles, zeros, and DC gain.
These commands apply to both continuous- and discrete-time models. Their
LTI-based syntax is summarized in the table below.

Commands to Query Model Characteristics

Command

Description

size(model name)

Number of inputs and outputs

ndims(model name)

Number of dimensions

isct(model_name)

Returns 1 for continuous systems

isdt(model name)

Returns 1 for discrete systems

hasdelay(model name)

True if system has delays

pole(model name)

System poles

zero(model name)

System (transmission) zeros

dcgain(model name)

DC gain

norm(model_name)

System norms (H, and L)

covar(model name,W)

Covariance of response to white noise

bandwidth(model name)

Frequency response bandwidth

1ti/order(model name)

LTI model order

pzmap(model name)

Compute pole-zero map of LTI models

damp(model name)

Natural frequency and damping of system
poles
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Commands to Query Model Characteristics (Continued)

Command Description

class(model name) Create object or return class of object

isa(model name) Determine whether input is object of given
class

isempty(model name) Determine whether LTI model is empty

isproper(model name) Determine whether LTI model is proper

issiso(model name) Determine whether LTI model is
single-input/single-output (SISO)

1ti/isstable(model name) | Determine whether system is stable

reshape(model name) Change shape of LTI array
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Interconnecting Linear Models

In this section...

“Arithmetic Operations for Interconnecting Models” on page 2-23

“Feedback Interconnections” on page 2-24

Arithmetic Operations for Interconnecting Models

You can perform arithmetic on LTI models, such as addition, multiplication,
or concatenation. Addition performs a parallel interconnection. For example,

typing
tf(1,[1 01) + tf([1 11,[1 2]) % 1/s + (s+1)/(s+2)
produces this transfer function.

Transfer function:
s"2 +2s + 2

Multiplication performs a series interconnection. For example, typing
2 * tf(1,[1 O])*tf([1 1]1,[1 2]) % 2*1/s*(s+1)/(s+2)
produces this cascaded transfer function.

Transfer function:
2 s + 2

If the operands are models of different types, the resulting model type is
determined by precedence rules; see Precedence Rules for more information.
State-space models have the highest precedence while transfer functions have
the lowest precedence. Hence the sum of a transfer function and a state-space
model is always a state-space model.
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Other available operations include system inversion, transposition, and
pertransposition; see Arithmetic Operations. You can also perform matrix-like
indexing for extracting subsystems; see Extracting and Modifying Subsystems
for more information.

You can also use the series and parallel functions as substitutes for
multiplication and addition, respectively.

Equivalent Ways to Interconnect Systems

Operator Function Resulting Transfer Function
sys1l + sys2 parallel(sysi,sys2) | Systems in parallel

sys1 - sys2 parallel(sysi,-sys2) Systems in parallel

sysl * sys2 series(sys2,sys1) Cascaded systems

Feedback Interconnections

You can use the feedback and 1ft functions to derive closed-loop models.
For example,

sys_f = feedback(tf(1,[1 0]), tf([1 1],[1 2])

computes the closed-loop transfer function from r to y for the feedback loop
shown below. The result is

Transfer function:
s + 2

This figure shows the interconnected system in block diagram format.



Interconnecting Linear Models

r + ¥
f{T) | 1 -
B s
s+1
s+2 -

Feedback Interconnection
You can use the 1ft function to create more complicated feedback structures.

This function constructs the linear fractional transformation of two systems.
See the reference page for more information.
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Converting Between Continuous- and Discrete- Time

Systems

In this section...

“Available Commands for Continuous/Discrete Conversion” on page 2-26
“Available Methods for Continuous/Discrete Conversion” on page 2-26

“Digitizing the Discrete DC Motor Model” on page 2-26

Available Commands for Continuous/Discrete
Conversion

The commands c2d, d2¢, and d2d perform continuous to discrete, discrete to
continuous, and discrete to discrete (resampling) conversions, respectively.

sysd = c2d(sysc,Ts) % Discretization w/ sample period Ts
sysc d2c(sysd) % Equivalent continuous-time model
sysdi= d2d(sysd,Ts) % Resampling at the period Ts

Available Methods for Continuous/Discrete
Conversion

Various discretization/interpolation methods are available, including
zero-order hold (default), first-order hold, Tustin approximation with or
without prewarping, and matched zero-pole. For example,

ses first-order hold
ses Tustin approximation

sysd
sysc

c2d(sysc,Ts, 'foh') %

U
d2c(sysd, 'tustin') % U

Digitizing the Discrete DC Motor Model

You can digitize the DC motor plant using the c2d function and selecting an
appropriate sample time. Choosing the right sample time involves many
factors, including the performance you want to achieve, the fastest time
constant in your system, and the speed at which you expect your controller
to run. For this example, choose a time constant of 0.01 second. See “SISO
Example: The DC Motor” on page 2-3 for the construction of the SS object
sys_dc.

Ts=0.01;



Converting Between Continuous- and Discrete- Time Systems

sysd=c2d(sys_dc,Ts)

a =
X1 X2
X1 0.96079 -0.00027976
X2 0.006994 0.90484
b =
ui
x1 0.019605
X2 7.1595e-005
C =
X1 X2
y1 0 1
d =
ui
y1 0

Sampling time: 0.01
Discrete-time model.

To see the discrete-time zero-pole gain for the digital DC motor, use zpk to
convert the model.

fd=zpk(sysd)

Zero/pole/gain:
7.1595e-005 (z+0.9544)

(z-0.9608) (z-0.9049)
Sampling time: 0.01

You can compare the step responses of sys_dc and sysd by typing
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step(sys_dc,sysd)

This figure shows the result.
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Note the step response match. Continuous and FOH-discretized step
responses match for models without internal delays.
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Reducing Model Order

In this section...

“Model Order Reduction Commands” on page 2-29
“Techniques for Reducing Model Order” on page 2-29
“Example: Gasifier Model” on page 2-30

Model Order Reduction Commands
You can derive reduced-order SISO and MIMO models with the commands

shown in the following table.

Model Order Reduction
Commands

hsvd Compute Hankel singular values of LTI model
balred Reduced-order model approximation

minreal Minimal realization (pole/zero cancellation)
balreal Compute input/output balanced realization
modred State deletion in I/0 balanced realization
sminreal Structurally minimal realization

Techniques for Reducing Model Order

To reduce the order of a model, you can perform any of the following actions:

Eliminate states that are structurally disconnected from the inputs or

outputs using sminreal.

Eliminating structurally disconnected states is a good first step in model
reduction because the process is cheap and does not involve any numerical

computation.

Compute a low-order approximation of your model using balred.

Eliminate cancelling pole/zero pairs using minreal.
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Example: Gasifier Model

This example presents a model of a gasifier, a device that converts solid
materials into gases. The original model is nonlinear.

Loading the Model

To load a linearized version of the model, type

load ltiexamples

at the MATLAB prompt; the gasifier example is stored in the variable named
gasf. If you type

size(gasf)

you get in return

State-space model with 4 outputs, 6 inputs, and 25 states.

SISO Model Order Reduction

You can reduce the order of a single I/O pair to understand how the model
reduction tools work before attempting to reduce the full MIMO model as
described in “MIMO Model Order Reduction” on page 2-34.

This example focuses on a single input/output pair of the gasifier, input 5
to output 3.

sys35 = gasf(3,5);

Before attempting model order reduction, inspect the pole and zero locations
by typing

pzmap (sys35)
Zoom in near the origin on the resulting plot using the zoom feature or by
typing

axis([-0.2 0.05 -0.2 0.2])

The following figure shows the results.
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Pole-Zero Map of the Gasifier Model (Zoomed In)

Because the model displays near pole-zero cancellations, it is a good candidate
for model reduction.

To find a low-order reduction of this SISO model, perform the following steps:
1 Select an appropriate order for your reduced system by examining the
relative amount of energy per state using a Hankel singular value (HSV)
plot. Type the command
hsvd(sys35)
to create the HSV plot.

Changing to log scale using the right-click menu results in the following
plot.
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Small Hankel singular values indicate that the associated states contribute
little to the I/O behavior. This plot shows that discarding the last 10 states
(associated with the 10 smallest Hankel singular values) has little impact
on the approximation error.

2 To remove the last 10 states and create a 15th order approximation, type
rsys35 = balred(sys35,15);

You can type size(rsys35) to see that your reduced system contains only
15 states.

3 Compare the Bode response of the full-order and reduced-order models
using the bode command:

bode(sys35,'b',rsys35,'r--")

This figure shows the result.
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As the overlap of the curves in the figure shows, the reduced model provides
a good approximation of the original system.

You can try reducing the model order further by repeating this process and
removing more states. Reduce the gasf model to 5th, 10th, and 15th orders
all at once by typing the following command

rsys35 = balred(sys35,[5 10 15]);

Plot a bode diagram of these three reduced systems along with the full order
system by typing

bode(sys35, 'b',rsys35,'r--")
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Observe how the error increases as the order decreases.

MIMO Model Order Reduction

You can approximate MIMO models using the same steps as SISO models as

follows:

1 Select an appropriate order for your reduced system by examining the
relative amount of energy per state using a Hankel singular value (HSV)

plot.

Type

hsvd(gasf)

to create the HSV plot.
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Discarding the last 8 states (associated with the 8 smallest Hankel singular
values) should have little impact on the error in the resulting 17th order
system.

To remove the last 8 states and create a 17th order MIMO system, type

rsys=balred(gasf,17);

You can type size(gasf) to see that your reduced system contains only
17 states.

To facilitate visual inspection of the approximation error, use a singular
value plot rather than a MIMO Bode plot. Type

sigma(gasf, 'b',gasf-rsys,'r')

to create a singular value plot comparing the original system to the
reduction error.
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The reduction error is small compared to the original system so the reduced
order model provides a good approximation of the original model.
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Analyzing Models

® “Quick Start for Performing Linear Analysis Using the LTI Viewer” on
page 3-2

e “LTI Viewer” on page 3-7

¢ “Simulating Models with Arbitrary Inputs and Initial Conditions” on page
3-22

¢ “Functions for Time and Frequency Response” on page 3-37
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Quick Start for Performing Linear Analysis Using the LTI

Viewer

In this Quick Start, you learn how to analyze the time- and frequency-domain
responses of one or more linear models using the LTI Viewer GUI.

Before you can perform the analysis, you must have already created linear
models in the MATLAB workspace. For information on how to create a model,
see Chapter 2, “Building Models”.

To perform linear analysis:

1 Open the LTI Viewer showing one or more models using the following
syntax:

ltiview(modell,model2,...,modelN)

By default, this syntax opens a step response plot of your models, as shown
in the following figure.
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2 Add more plots to the LTI Viewer.
a Select Edit > Plot Configurations.

b In the Plot Configurations dialog box, select the number of plots to open.
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3 To view a different type of response on a plot, right-click and select a plot
type.
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4 Analyze system performance. For example, you can analyze the peak
response in the Bode plot and settling time in the step response plot.

a Right-click to select performance characteristics.

b Click on the dot that appears to view the characteristic value.
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LTI Viewer

In this section...

“Plot Types Available in the LTI Viewer” on page 3-7

“Example: Time and Frequency Responses of the DC Motor” on page 3-8
“Right-Click Menus” on page 3-10

“Displaying Response Characteristics on a Plot” on page 3-11
“Changing Plot Type” on page 3-14

“Showing Multiple Response Types” on page 3-16

“Comparing Multiple Models” on page 3-17

Plot Types Available in the LTI Viewer

The LTI Viewer is a GUI for viewing and manipulating the response plots of

linear models. You can display the following plot types for linear models
using the LTI Viewer:

® Step and impulse responses

® Bode and Nyquist plots

¢ Nichols plots

e Singular values of the frequency response

e Pole/zero plots

® Response to a general input signal

¢ Unforced response starting from given initial states (only for state-space
models)

Note that time responses and pole/zero plots are not available for FRD models.

Note The LTI Viewer displays up to six different plot types simultaneously.

You can also analyze the response plots of several linear models at once.
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This figure shows an LTI Viewer with two response plots.
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The LTI Viewer with Step and Impulse Response Plots

The next section presents an example that shows you how to import a system
into the LTI Viewer and how to customize the viewer to fit your requirements.

Example: Time and Frequency Responses of the DC
Motor

“SISO Example: The DC Motor” on page 2-3 presents a DC motor example. If
you have not yet built that example, type

load ltiexamples

at the MATLAB prompt. This loads several LTI models, including a
state-space representation of the DC motor called sys_dc.



LTl Viewer

Opening the LTI Viewer
To open the LTI Viewer, type

ltiview
This opens an LTI Viewer with an empty step response plot window by default.

Importing Models into the LTI Viewer

To import the DC motor model, select Import under the File menu. This
opens the Import System Data dialog box, which lists all the models available
in your MATLAB workspace.

<) Import System Data =1ox]
— Impoart fram
Systems in Workspace
% Workspace G 1zl cf -
® Gcll 1xl tf _I
 MAT-file Golz 1xl tf
Geolz 1xl tf
Gserwvo 1xl zpk
clssFE ZxZ ss
diskdrive 1xl zpk
frdFg ZxZ frd
frdi 1xl frd
gasf dxE ==
i lant 1xl ==
mZd 4-Ir tf
=sF& Z2xZ ss
Browyse | LI

Ok | Cancel I Help I

Import System Data Dialog Box with the DC Motor Model Selected

Select sys_dc from the list of available models and click OK to close the
browser. This imports the DC motor model into the LTI Viewer.

To select more than one model at a time, do the following:

® To select individual (noncontiguous) models, select one model and hold
down the Ctrl key while selecting additional models. To clear any models,
hold down the Ctrl key while you click the highlighted model names.

® To select a list of contiguous models, select the first model and hold down
the Shift key while selecting the last model you want in the list.
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The figure below shows the LTI Viewer with a step response for the DC
motor example.
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Alternatively, you can open the LTI Viewer and import the DC motor example
directly from the MATLAB prompt.

ltiview('step', sys_dc)

See the 1tiview reference page for a complete list of options.

Right-Click Menus

The LTI Viewer provides a set of controls and options that you can access by
right-clicking your mouse. Once you have imported a model into the LTI
Viewer, the options you can select include

® Plot Types — Change the plot type. Available types include step, impulse,
Bode, Bode magnitude, Nichols, Nyquist, and singular values plots.
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e Systems — Select or clear any models that you included when you created
the response plot.

¢ Characteristics — Add information about the plot. The characteristics
available change from plot to plot. For example, Bode plots have stability
margins available, but step responses have rise time and steady-state
values available.

e Grid — Add grids to your plots.

® Normalize — Scale responses to fit the view (only available for
time-domain plot types).

e Full View — Use automatic limits to make the entire curve visible.

* Properties — Open the Property Editor.

«): Property Editor: Step Response 10l =|

Labels | Linits | unts | Styie | options |

Labels

Title: Fep Response

H-Label  [Tine

-Label  lamplitude

Close | Help |

You can use this editor to customize various attributes of your plot. See
Customizing Plot Properties and Preferences for a full description of the
Property Editor.

Alternatively, you can open the Property Editor by double-clicking in an
empty region of the response plot.

Displaying Response Characteristics on a Plot

For example, to see the rise time for the DC motor step response, right-click
and select Characteristics > Rise Time.
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) LTI Yiewer (=] ]
File Edit ‘Window Help
0D&| & & | E
Step Response
.04 T T
0.035 - ~
003 - ~
Flot Types »
Oz Systems » T
] Characteristics Peak Response
£ 002 5 A g
= Grid Settling Time

omaze
0.015 v Full View Steady State 1
Properties... |
0o b

0.005 - -

il I I
o 0s 1 15

Time (zec)

LTI igweer

Using Right-Click Menus to Display the Rise Time for a Step Response

By default, the rise time is defined as the amount of time it takes the step
response to go from 10% to 90% of the steady-state value. You can change this
range in the options tab of the property editor. For more information on the
property editor, see Customizing Plot Properties and Preferences.

The LTI Viewer calculates and displays the rise time for the step response.
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il
File Edit ‘Window Help
0D& & E
Step Response
.04
e The dot marks the 90%
oosl | ! value for the rise fime.
I I
opsp | ! This line shows when the
g ' T | response reaches 10% of its
- ! ! steady-state value.
0.01s - ! ! b
I I
oo b | This line shows when the
| | response reaches 90% of its
pos e | 7 | steady-state valve.
il i I 1 I
1] 0.5 1 1.5
Time (zec)
LTI igweer

DC Motor Step Response with the Rise Time Displayed

To display the values of any plot characteristic marked on a plot, place
your mouse on the blue dot that marks the characteristic. This opens a
data marker with the relevant information displayed. To make the marker
persistent, left-click the blue dot.

For example, this figure shows the rise time value for the DC motor step
response.
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001 - | | 1 .
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|
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Using Your Mouse to Get the Rise Time Values

Note that you can left-click anywhere on a particular plot line to see the
response values of that plot at that point. You must either place your cursor
over the blue dot or left-click, however, if you want to see the rise time value.

For more information about data markers, see “Data Markers” on page 3-42.

Changing Plot Type

You can view other plots using the right-click menus in the LTI Viewer. For
example, if you want to see the open loop Bode plots for the DC motor model,
select Plot Type and then Bode from the right-click menu.
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) LTI Yiewer (=] ]
File Edit ‘Window Help
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Changing the Step Response to a Bode Plot

Selecting Bode changes the step response to a Bode plot for the DC motor
model.
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Bode Plot for the DC Motor Model

Showing Multiple Response Types

If you want to see, for example, both a step response and a Bode plot at the
same time, you have to reconfigure the LTI Viewer. To view different response
types in a single LTI Viewer, select Plot Configurations under the Edit
menu. This opens the Plot Configurations dialog box.
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<) Plot Configurations =10l

e 5 C 1 5 - 21 4 ILinearSimuI... d
5 [Initial Condii... -

Select lot configurati
elect a response plot configuration N

“ ; “ ] o 1 1: IBDdE d
2 Z IStep d
2
3
3 [impube - Select Response type for each

pane in the seleded arrangement.

mofjeoejoon| ===
B |Bode Magnit.. -

QK | Cancell Help | Apply |

Using the Plot Configurations Dialog Box to Reconfigure the LTI Viewer

You can select up to six plots in one viewer. Choose the Response type for
each plot area from the right-side menus. There are nine available plot types:

Step

Impulse

Linear Simulation
Initial Condition

Bode (magnitude and phase)
Bode Magnitude (only)
Nyquist

Nichols

Singular Value
Pole/Zero

1/0 pole/zero

Comparing Multiple Models

This section shows you how to import and manipulate multiple models in
one LTI Viewer. For example, if you have designed a set of compensators to
control a system, you can compare the closed-loop step responses and Bode
plots using the LTI Viewer.
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A sample set of closed-loop transfer function models is included (along with
some other models) in the MAT-file 1tiexamples.mat. Type

load ltiexamples

to load the provided transfer functions. The three closed-loop transfer function
models, Gcl1, Gecl2, and Gel3, are for a satellite attitude controller.

In this example, you analyze the response plots of the Gc11 and Gcl2 transfer
functions.

Initializing the LTI Viewer with Multiple Plots

To load the two models Gel1 and Gel2 into the LTI Viewer, select Import
under the File menu and select the desired models in the LTI Browser. See
“Importing Models into the LTI Viewer” on page 3-9 for a description of how
to select groups of models. If necessary, you can reconfigure the viewer to
display both the step responses and the Bode plots of the two systems using
the Viewer Configuration dialog box. See “Showing Multiple Response Types”
on page 3-16 for a discussion of this feature.

Alternatively, you can open an LTI Viewer with both systems and both the
step responses and Bode plots displayed. To do this, type

ltiview({'step';'bode'},Gcl1,Gcl2)

Either approach opens the following LTI Viewer.
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Multiple Response Plots in a Single LTI Viewer

Inspecting Response Characteristics

To mark the settling time on the step responses presented in this example,
do the following:

¢ Right-click anywhere in the plot region of the step response plots. This
opens the right-click menu list in the plot region.

¢ Select Characteristics > Settling Time.

To mark the stability margins of the Bode plot in this example, right-click and
select Characteristics > Minimum Stability Margins.

Your LTI Viewer should now look like this.
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Multiple Plots with Response Characteristics Added

The minimum stability margins, meaning the smallest magnitude phase and
gain margins, are displayed as green and blue markers on the Bode phase
diagram. If you want to see all the gain and phase margins of a system,
right-click and select Characteristics > Minimum Stability Margins.

Toggling Model Visibility

If you have imported more than one model, you can select and clear which
models to plot in the LTI Viewer using right-click menus. For example, if you
import the following three models into the viewer, you can choose to view any
combination of the three you want.

s=tf('s');

sys1=1/(s"2+s+1);
sys2=1/(s"2+s+2);
sys3=1/(s"2+s+3);
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This figure shows how to clear the second of the three models using right-click
menu options.

il
File Edit ‘Window Help
0D& & E
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12F 1
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L R e S systems you want to
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_______________________________ arid right-click menu. The
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S v Full Yiew 1 N
-------------------------- = : that you have imported
Properties... . .
aal i info the LTI Viewer.
D 1 1 1 1 1
u} 2 4 E g 10 12
Time (zec)
LTI Wiewver

Using Right-Click Menus to Select/Clear Plotted Systems

The Systems menu lists all the imported models. A system is selected if a
check mark is visible to the left of the system name.
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Simulating Models with Arbitrary Inputs and Initial

Conditions

In this section...

“What is the Linear Simulation Too0l?” on page 3-22
“Opening the Linear Simulation Tool” on page 3-22
“Working with the Linear Simulation Tool” on page 3-23
“Importing Input Signals” on page 3-26

“Example: Loading Inputs from a Microsoft® Excel Spreadsheet” on page
3-28

“Example: Importing Inputs from the Workspace” on page 3-29
“Designing Input Signals” on page 3-33
“Specifying Initial Conditions” on page 3-35

What is the Linear Simulation Tool?

You can use the Linear Simulation Tool to simulate linear models with

a

rbitrary input signals and initial conditions.

The Linear Simulation Tool lets you do the following:

Import input signals from the MATLAB workspace.

Import input signals from a MAT-file, Microsoft® Excel® spreadsheet,
ASCII flat-file, comma-separated variable file (CSV), or text file.

Generate arbitrary input signals in the form of a sine wave, square wave,
step function, or white noise.

Specify initial states for state-space models.

Default initial states are zero.

Opening the Linear Simulation Tool

To open the Linear Simulation Tool, do one of the following:
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e In the LTI Viewer, right-click the plot area and select Plot Types >
Linear Simulation.

e Use the 1sim function at the MATLAB prompt:

1sim(modelname)

¢ In the MATLAB Figure window, right-click a response plot and select
Input data.

Working with the Linear Simulation Tool

The Linear Simulation Tool contains two tabs, Input signals and Initial
states.

After opening the Linear Simulation Tool (as described in “Opening the Linear
Simulation Tool” on page 3-22), follow these steps to simulate your model:

1 Click the Input signals tab, if it is not displayed.

=10l x|

«): Linear Simulation Tool

File Edit Help

Input signals | nitsl states |

~Timing

Murnber of samples:

Start time (zec) 0 fo I with an interval of I

Impart time ﬂ-

~System input:

Channels

Data Wariahle Dimensions

The Input signals tab lets you import
input signals or design your own.

| Specify your simulation times here, or
import a time vector.

Click Import signal to import data from

Use "lmport signal.." or "Design signal..." buttons to assign d

a file.

Impart signal....

— (lick Design signul to create an input
Design signal... .
| ﬂl signal.

Simulate | Cloze |

Interpolstion method: I Automatic Vl
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2 In the Timing area, specify the simulation time vector by doing one of
the following:

e Import the time vector by clicking Import time.
e Enter the end time and the time interval in seconds. The start time
1s set to 0 seconds.
3 Specify the input signal by doing one of the following:

¢ (Click Import signal to import it from the MATLAB workspace or a file.
For more information, see “Importing Input Signals” on page 3-26.

¢ (Click Design signal to create your own inputs. For more information,

see “Designing Input Signals” on page 3-33.

4 If you have a state-space model and want to specify initial conditions, click
the Initial states tab. By default, all initial states are set to zero.

You can either enter state values in the Initial value column, or import
values by clicking Import state vector. For more information about
entering initial states, see “Specifying Initial Conditions” on page 3-35.
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1 : : = The Initial states tab is available
=k Li il i _I I x . .

'Lm e 5 SO = when you are working with at least
one stafe-space system.

Input signals  Initial states

Selectedt syster | sys_ac v | This list contains names of state-space
~Specity initial state: systems.
State name Initial value
stater 11

Enfer inifial-state values. Default
state2 5 - values are zero.

Click Import state vector to import

Import state vectaor... HI II'IIIIEII states.
Interpolstion method: IAutomatic: Vl Simulate: | Close |

5 For a continuous model, select one of the following interpolation methods in
the Interpolation method list to be used by the simulation solver:

® Zero order hold
¢ First order hold (linear interpolation)

® Automatic (Linear Simulation Tool selects first order hold or zero order
hold automatically, based on the smoothness of the input)

Note The interpolation method is not used when simulating discrete
models.

6 Click Simulate.
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Importing Input Signals

You can import input signals from the MATLAB workspace after opening
the Linear Simulation Tool (see “Opening the Linear Simulation Tool” on
page 3-22). You can also import inputs from a MAT-file, Microsoft Excel
spreadsheet, ASCII flat-file, comma-separated variable file (CSV), or text file.

For information about creating your own inputs, see “Designing Input
Signals” on page 3-33. For an overview of working with the Linear Simulation
Tool, see “Working with the Linear Simulation Tool” on page 3-23.

To import one or more input signals:

1 In the Linear Simulation Tool, click the Input signals tab, if it is not
displayed.

2 Specify the simulation time in the Timing area.

3 Select one or more rows for the input channels you want to import. The
following figure shows an example with two selected channels.
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Linear Simulation Tool 10l =|

File Edit Help

Input signals | nitsl states |
~Titmingy

Start time (zec) 0 fo |1 with an interval of |.1
Murnber of samples: 11 Impart time |

~System input:

Channels Data

Wariahle Dimensions

Multi-select

Impart signal.... | Design signal... |

Interpolstion method: IAutomatic: Vl Simulate: | Close |

4 Click Import signal to open the Data Import dialog box. The following
figure shows an example of the Data Import dialog box.

-loix]

Impart from: | Workspace = l

Wariahle Name | Size | Eytes | Class |
Ha 22 a2 double
Hn 21 16 double
He 152 16 double
HHa 131 ] double
* Azsign columns |1 to selected channel(s)

(o Assign rovws |[1 100]  to selected channel(=)

Import | Close | Help |
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5 In the Import from list, select the source of the input signals. It can be
one of the following:

® Workspace
® MAT file

e XLS file

® (CSV file

® ASCII file

6 Select the data you want to import. The Data Import dialog box contains
different options depending on which source format you selected.

7 Click Import.
For an example of importing input signals, see the following:

e “Example: Loading Inputs from a Microsoft® Excel Spreadsheet” on page
3-28

¢ “Example: Importing Inputs from the Workspace” on page 3-29

Example: Loading Inputs from a Microsoft Excel
Spreadsheet
To load inputs from a Microsoft Excel (XLS) spreadsheet:

1 In the Linear Simulation Tool, click Import signal in the Input signals
tab to open the Data Import dialog box.

2 Select XLsS file in the Import from list.
3 Click Browse.

4 Select the file you want to import and click Open. This populates the Data
Import dialog box with the data from the Microsoft Excel spreadsheet.
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Ziid| 1 your spredsheet hs mulipl
L worksheets, select one from this
Impaart fram: |><|_s file vl list.
File: IH:\Documents\TS\or Browyse... Select sheet: | onboard =~
Click a column to select it. Press
A B | . | Shift o select multiple
1 |Time Diata N
=T cans g = | contiguous columns; press Ctrl
3 10 2428 to select nonadjacent columns.
4 |20 9435.4
5 |30 9451 6
& |40 Q460 2 =l
Text and Missing Dt Enter the number of the first row
lgnore header rovs prior to row: |2 " il'lﬂi COI'Ih:IiI'IS dlﬂﬂ.
Bec deta substiution methodt | Sep rows et Bad data contains strings or
missing values. Select fo skip
wiot | cose | oo | cellsor rows, linearly interpolate
between good data values, or
use zero-order hold.

Example: Importing Inputs from the Workspace
To load an input signal from the MATLAB workspace:

1 Enter this code to open a response plot with a second-order system:

s=tf('s');
ss=(s+2)/(s"2+3*s+2);
1sim(ss,randn(100,1),1:100);

2 Right-click the plot background and select Input data.
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Drowes -ioix

File Edit Wiew Insert Tools Desktop Window Help N
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Linear Simulation Results

Syskems 3
Characteristics ~ #
 Show Input

0s Grid
MNaormalize
z a w Full View 5
g MI
[=3
g 0s Initial condition, T

Properties...
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This opens the Linear Simulation Tool with default input data.
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«): Linear Simulation Tool =10l =]
File Edit Help

Inita states |

Start time (zec) 1 fo I1DD with an interval of I1.DDD
Murnber of samples: 100 Impart time |

~System input:

Channels Data Wariahle Dimensions

clefautti1:100,1) 1001

Criginally loaded from: Initial data, Original input #1

Impart signal.... | Design signal... |

Interpolstion method: IAutomatic: Vl Simulate: | Close |

3 Create an input signal for your system in the MATLAB Command Window,
such as the following:

new_signal=[-3*ones(1,20) 2*ones(1,30) 0.5*ones(1,50)]"';
4 In the Linear Simulation Tool, click Import signal.

5 In the Data Import dialog box, click, Assign columns to assign the first
column of the input signal to the selected channel.
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Data Imporkt 3] x|
Impart from: | Workspace Vl

Wariahle Name | Size | Eytes | Class |
HH news_signal 1001 800 double
* Azsign columns |1 to selected channel(s)

(o Assign rovws |[1 100]  to selected channel(=)

Import | Close | Help |

6 Click Import. This imports the new signal into the Linear Simulation Tool.

inear Simulation Tool 10l =|

File Edit Help

Input signals | nitsl states |

~Timing

Start time (zec) 1 fo I1DD with an interval of I1.DDD
Murnber of samples: 100 Impart time |

~System input:

Channels Data Wariahle Dimensions

Criginally loaded from: Workspace, Variable name: new_signal
Column number: 1

Impart signal.... | Design signal... |

Interpolstion method: IAutomatic: Vl Simulate: | Close |
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7 Click Simulate to see the response of your second-order system to the
imported signal.

-ioix

File Edit Wiew Insert Tools Web Desktop Window Help

Ded&S k2200 [ |OBFOOCMN N AFO0O

Linear Simulation Results

Amplitude:

10 20 30 40 a0 (=11) i) a0 a0 100
Time (zec)

Designing Input Signals

You can generate arbitrary input signals in the form of a sine wave, square
wave, step function, or white noise after opening the Linear Simulation Tool
(see “Opening the Linear Simulation Tool” on page 3-22).

For information about importing inputs from the MATLAB workspace or from
a file, see “Importing Input Signals” on page 3-26. For an overview of working
with the Linear Simulation Tool, see “Working with the Linear Simulation
Tool” on page 3-23.

To design one or more input signals:

1 In the Linear Simulation Tool, click the Input signals tab (if it is not
displayed).
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2 Specify the simulation time in the Timing area. The time interval (in
seconds) 1s used to evaluate the input signal you design in later steps of

this procedure.

3 Select one or more rows for the signal channels you want to design. The
following figure shows an example with two selected channels.

=10l x|

«): Linear Simulation Tool
File Edit Help

input sianals | it stetes |

~Timing

Start time (zec) 0 fo |1 with an interval of |.1
Murnber of samples: 11 Impart time |

~System input:

Wariahle Dimensions

Channels Data

Multi-select

Impart signal.... | Design signal... |

Interpolstion method: IAutomatic: Vl Simulate: | Close |

4 Click Design signal to open the Signal Designer dialog box. The following
figure shows an example of the Signal Designer dialog box.
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«): Signal Designer -0 x|

Signal type: IStep function Vl

Signal sttributes:

Mame: IStep'I

Starting level: ID

Step size: |1

Transition time (secs): IQD—

Duration (secs): 100

Close | Help |

5 In the Signal type list, select the type of signal you want to create. It
can be one of the following:

® Sine wave
® Square wave
® Step function

e White noise

6 Specify the signal characteristics. The Signal Designer dialog box contains
different options depending on which signal type you selected.

7 Click Insert. This brings the new signal into the Linear Simulation Tool.
8 Click Simulate in the Linear Simulation Tool to view the system response.
Specifying Initial Conditions

If your system is in state-space form, you can enter or import initial states

after opening the Linear Simulation Tool (see “Opening the Linear Simulation
Tool” on page 3-22).

For an overview of working with the Linear Simulation Tool, see “Working
with the Linear Simulation Tool” on page 3-23.

You can also import initial states from the MATLAB workspace.
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To import one or more initial states:

1 In the Linear Simulation Tool, click the Initial states tab (if it is not
already displayed).

2 In the Selected system list, select the system for which you want to
specify initial conditions.

3 You can either enter state values in the Initial value column, or import
values from the MATLAB workspace by clicking Import state vector.
The following figure shows an example of the import window:

<} Import initial condition from wo x|

Wariable Namsl Size | Eytes | Class |

Einito 152 16 double &
Einit1 152 16 double J
EHinitz 152 16 double

FH initz 1%2 16 double »|

Impart | Close |

Note For n-states, your initial-condition vector must have n entries.

4 After specifying the initial states, click Simulate in the Linear Simulation
Tool to view the system response.
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Functions for Time and Frequency Response

In this section...

“When to Use Functions for Time and Frequency Response” on page 3-37
“Time and Frequency Response Functions” on page 3-37

“Plotting MIMO Model Responses” on page 3-40

“Data Markers” on page 3-42

“Plotting and Comparing Multiple Systems” on page 3-44

“Creating Custom Plots” on page 3-47

When to Use Functions for Time and Frequency
Response

You can use the LTI Viewer GUI for a wide range of applications. There

are situations, however, where you may want a more open and extensible
environment. You can use the Control System Toolbox functions for basic
time and frequency domain analysis plots used in control system engineering.
These functions apply to any kind of linear model (continuous or discrete,
SISO or MIMO, or arrays of models). You can only apply the frequency
domain analysis functions to FRD models.

Use the LTI Viewer when a GUI-driven environment is desirable. On the
other hand, use functions when you want customized plots. If you want to
include data unrelated to your models, you must use functions instead of the
LTI Viewer (which only plots model data).

The next sections discuss time and frequency response functions and how to
use these functions to create customized plots of linear model responses.

Time and Frequency Response Functions

Time responses investigate the time-domain transient behavior of linear
models for particular classes of inputs and disturbances. You can determine
such system characteristics as rise time, settling time, overshoot, and
steady-state error from the time response. You can use the Control System
Toolbox functions for step response, impulse response, initial condition
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response, and general linear simulations. For example, you can simulate the
response to white noise inputs using 1sim and the MATLAB function randn.

In addition to time-domain analysis, you can use the Control System Toolbox
functions for frequency-domain analysis using the following standard plots:

* Bode
Nichols

Nyquist

® Singular value

This table lists available time and frequency response functions and their use.

Functions for Frequency and Time Response

Functions Description

bode Bode plot

evalfr Computes the frequency response at a single complex
frequency (not for FRD models)

fregresp Computes the frequency response for a set of
frequencies

gensig Input signal generator (for 1sim)

impulse Impulse response plot

initial Initial condition response plot

iopzmap Pole-zero map for each I/0 pair of an LTI model

lsim Simulation of response to arbitrary inputs

margin Computes and plots gain and phase margins

nichols Nichols plot

nyquist Nyquist plot

pzmap Pole-zero map

step Step response plot




Functions for Time and Frequency Response

Functions for Frequency and Time Response (Continued)

Functions Description
hsvd Compute Hankel singular values of LTI model
bodemag Bode magnitude response of LTI models

These functions can be applied to single linear models or LTI arrays.

The functions step, impulse, and initial automatically generate an
appropriate simulation horizon for the time response plots. For example,

h = tf([1 0],[1 2 10])

impulse (h)

produces the following plot.

T —— ~=lol x|

File Edit Wiew Insert Tools Desktop Window Help

WIS ENEE =

Impulze Response

Amplitude

Time (zec)

Impulse Response of a SISO Model

3-39



3 Analyzing Models

3-40

Frequency-domain plots automatically generate an appropriate frequency
range as well.

Plotting MIMO Model Responses

For MIMO models, time and frequency response functions produce an array
of plots with one plot per I/O channel (or per output for initial and 1sim).
For example,

h = [tf(10,[1 2 10]1) , tf(1,[1 1]1)]
step(h)

produces the following plot.

T —— ~=lol x|

File Edit Wiew Insert Tools Desktop Window Help

DeEE s |aams €| 0B 8O

Step Response
From: Ini1) From: In2)

Amplitude:

| | | |
1] 2 4 6 0 2 4 G
Time (zec)

Step Responses for a MIMO Model

The simulation horizon is automatically determined based on the model
dynamics. You can override this automatic mode by specifying a final time,

step(h,10) % Simulates from 0 to 10 seconds
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or a vector of evenly spaced time samples.

t =0:0.01:10 % Time samples spaced every 0.01 second
step(h,t)

Right-Click Menus

All the time and frequency response functions provide right-click menus
that allow you to customize your plots. For more information on using the
LTI Viewer right-click menus, see “Using the Right-Click Menu in the LTI
Viewer”. This figure shows the plots from Step Responses for a MIMO Model
on page 3-40, with the right-click menu open.

=loix

File Edit Wiew Insert Tools Web Desktop Window Help
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Step Response
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Systems ] |

Amplitude:
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|
|
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| I/ Grouping
i 1/ Selector... Rise: Time
|
|
|
|

o g Steady State

Grid
MNaormalize

02 w Full View

Properties...

| | I | |
1] 2 4 6 0 2 4 =
Time (zec)

Using the Right-Click Menu in a Step Response Plot

The options you can select include
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Systems — Select or clear any models that you included when you created
the response plot.

Characteristics — Add information about the plot. The characteristics
available change from plot to plot. For example, Bode plots have stability
margins available, but step responses have rise time and steady-state
values available.

Axes Grouping — Change the grouping of your plots. Available options
are All, None, Inputs, and Outputs. You can group all the plots together,
place each in a separate plot region (none), or group the inputs or outputs
together.

I/0 Selector — Open the I/O Selector dialog box.

-ioix
[all] (1 (2
Outi1) * *
Cloze | Help |

Use this dialog box to select/clear which inputs and outputs to plot.

Normalize — Scale responses to fit the view (only available for
time-domain plot types).

Full View — Use automatic limits to make the entire curve visible.
Grid — Add grids to your plots.

Properties — Open the Property Editor, which you can use to customize
various attributes of your plot. See Customization for a full description of
the Property Editor.

Alternatively, you can open the Property Editor by double-clicking in an
empty region of the response plot.

Data Markers

In addition to right-click menus, you can use plot data markers. These allow
you to identify key data points on your plots. This figure, using the same
plot as Step Responses for a MIMO Model on page 3-40, shows markers on
the plots.
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Using Plot Markers to Identify Data Points
You can move a data marker by

® Grabbing the black square located at the corner of the marker

® Dragging the marker with your mouse

The time and amplitude values will change as you move the marker. This
does not apply to markers that display plot characteristics (e.g., peak value or
rise time). In the case of plot characteristic data markers, you can view them
by placing your cursor over the dot that represents the active characteristic.
To make the data marker persistent, left-click the marker.

Note Data markers do not apply to the SISO Design Tool, which displays
data about plot characteristics in the status pane at the bottom of the SISO
Design Tool window.
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Right-Click Menus

Right-click on any data marker to open a property menu for the marker.

Alignment  #

FonksSize b
v Movable
Delete

Interpolation ¥

Property options for the marker include

¢ Alignment — Change the position of the marker. Available options are
top-right, top-left, bottom-right, and bottom-left.

* FontSize — Change the font size.

e Movable — By default, you can move data markers by clicking and
dragging. Clearing Movable forces the marker to remain at a fixed data
point.

* Delete — Remove the selected marker. Alternatively, left-click anywhere
in the empty plot region to delete all markers in the plot

¢ Interpolation — By default, data markers linearly interpolate between
points along the plotted curve. Select None to force the markers to snap to
nearest points along the plotted curve.

Since characteristic data markers are by definition fixed, the right-click
menus for them have fewer options.

Alignment ¥
FontSize  »
Delete

These options work the same as they do for the full right-click menu.

Plotting and Comparing Multiple Systems

You can use the command-line response-plotting functions to plot the
response of continuous and discrete linear models on a single plot. To do
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so, invoke the corresponding command-line function using the list sys1,...,
sysN of models as the inputs.

stepplot(sysi,sys2,...,sysN)
impulseplot(sysi,sys2,...,sysN)

bodeplot(sysi,sys2,...,sysN)
nicholsplot(sysi,sys2,...,sysN)

All models in the argument lists of any of the response plotting functions
(except for sigma) must have the same number of inputs and outputs.
To differentiate the plots easily, you can also specify a distinctive
color/linestyle/marker for each system just as you would with the plot
command. For example,

bodeplot(syst, 'r',sys2,'y--"',sys3, 'gx")

plots sys1 with solid red lines, sys2 with yellow dashed lines, and sys3 with
green X markers.

You can plot responses of multiple models on the same plot. These models do
not need to be all continuous-time or all discrete-time.

Example: Comparing Continuous and Discretized Systems

The following example compares a continuous model with its zero-order-hold
discretization.

sysc tf(1000,[1 10 1000])
sysd c2d(sysc,0.2)
% ZOH sampled at 0.2 second

stepplot(sysc,'--"',sysd,'-")
% Compare step responses

These commands produce the plot shown below.
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Comparison of a Continuous Model to Its Discretized Version
Use this command to compare the Bode plots of the two systems.

bodeplot(sysc,'--"',sysd,'-")
% Compare Bode responses

The following plot results from the last command.
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Comparison of Bode Plots for a Continuous Model and lis Discretized Version

A comparison of the continuous and discretized responses reveals a drastic
undersampling of the continuous-time system. Specifically, there are hidden
oscillations in the discretized time response and aliasing conceals the
continuous-time resonance near 30 rad/sec.

Creating Custom Plots

Time and frequency response commands are useful for creating custom plots.
You can mix model response plots with other data views using response
commands together with plot, subplot, and hold.

Example: Custom Plots
For example, the following sequence of commands displays the Bode plot, step
response, pole/zero map, and some additional data in a single figure window.

h = tf([4 8.4 30.8 60],[1 4.12 17.4 30.8 60]);
subplot(221)
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bodeplot(h)

subplot(222)

stepplot(h)

subplot(223)

pzplot(h)

subplot(224)

plot(rand(1, 100)) % Any data can go here
title('Some noise')

Your plot should look similar to this illustration.
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Example of Creating a Custom Plot
For information about plot, subplot, hold, and other options for plotting

general data, see Basic Plots and Graphs in the MATLAB Function Reference.
These documents are available in the MATLAB online help.
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Note Each of the plots generated by response analysis functions in Example
of Creating a Custom Plot on page 3-48 (bodeplot, stepplot, and pzplot)
has its own right-click menu (similar to those in the LTI Viewer). To activate
the right-click menus, place your mouse in the plot region and right-click. The
menu contents depend on what type of plot you have selected.
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® “Quick Start for Tuning Compensator Parameters Using the SISO Design
Tool” on page 4-2

e “SISO Design Tool” on page 4-13

¢ “Bode Diagram Design” on page 4-29

® “Root Locus Design” on page 4-55

¢ “Nichols Plot Design” on page 4-82

¢ “Automated Tuning Design” on page 4-93

e “Multi-Loop Compensator Design” on page 4-99

¢ “Functions for Compensator Design” on page 4-111
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Quick Start for Tuning Compensator Parameters Using
the SISO Design Tool

In this Quick Start, you get an overview of the steps for tuning compensator
parameters. Before you begin, you need:

* A model in the MATLAB workspace representing your plant

For information on how to create a model, see Chapter 2, “Building Models”.

¢ Design requirements for your system

To tune parameters:

1 Open the control design GUIs by typing the following in the MATLAB
Command Window:

sisotool

This command opens the Control and Estimation Tools Manager and the
SISO Design Tool, as shown in the following figure.
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Open-loop phase plot.
Right click for design options.
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2 Define the control architecture for your system.

a In the Architecture tab of the Control and Estimation Tools Manager,
click Control Architecture.

b In the Control Architecture dialog box, select the control architecture.

¢ Specify the sign of summing junctions as + or -.

Architecture I Compensator Editar | Graphical Tuningl Analysis Plots | Automated Tuning

—{Fl0 | G

Current Architecture:

Loop Configuration. .. | Configure additional loop openings For mulki-loop design,

System Data ... \ Import data for compensatars and fixed systems.,
Sample Time Conversian ... | ange the sample time of the design.
) Control Architecture (=] B3]
Select Cortrol Architecture: du dy
oreor § o |
1 s S C - » G 2 N

Select ﬂw 51

control —™

architecture JEET
_Eil_ 5igns | Blacks and Signals |
-D-Iﬁ- Identifier Sign

51 -1 I
=) 1

&
T
[y

I —my

OK | Cancel I Help I

Specify sign of
summing junctions
as+or-



Quick Start for Tuning Compensator Parameters Using the SISO Design Tool

3 Specify the plant model and initial guesses for the compensator elements
in the control architecture.

a In the Architecture tab of the Control and Estimation Tools Manager,
click System Data.

b In the System Data dialog box, browse for a model in the MATLAB
workspace.

Architecture I Compensator Editar | Graphical Tuningl Analysis Plots | Automated Tuning

—{Fl0 | G

Current Architecture:

H
L |
| Cantrol Architecture ... I Maodify architecture, labels and feedback signs.
Loop Configuratian. .. | Configure additional loop openings for multi-loop design.

< System Data ... a | Import data for compensatars and fixed systems.,

Sample Time Conversian \l Change the sample time of the design.

=] system Data x|
~Impart Madel

System Daka

1=
— ==

Browse ... |

QK | Cancel | Help |

Browse for
model in MATLAB
workspace
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4 Design a compensator using automated tuning, for example PID Tuning.

a In the Automated Tuning tab of the Control and Estimation Tools
Manager, select an automated tuning method.
b Specify tuning options.

¢ Click Update Compensator to tune parameters.

nrchitactural Compensataor Editorl Graphical Tuningl Analysis Plots  Automated Tuning |
Selact d Design method: -
aUt_Omate ptimization Based Tuning
tuning method |- Compensator

[nternal Model Control (IMC) Tuning

IC LQG Synthesis

Loop Shaping

~ Specifications

SpeCIfy B Contraller bype: P =PI * PID

tuning options R
= PID with derivative filker 1/(14s/M). N frequency:  |100

Tuning algarithm: I Singular frequancy based tuning j

Performance metric: I Integral Absolute Error (IAE) LI

Update Compensataor

Tune parameters
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5 Evaluate the system’s closed-loop performance.

a Plot the system response.

i In the Analysis Plots tab, select a plot type.

ii Select the type of response for each plot.

Select plot
type

Select the type
of response for
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b Display specific performance characteristic for your system. Compare
values to design requirements.

iii Right-click to select performance characteristics.

iv Click on the dot that appears to view the characteristic value.

Click dot
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6 Refine compensator design using graphical tuning.

a Create plots for graphical tuning.

i In the Graphical Tuning tab, select the loop to tune in each plot.

ii Select plot types.

Select the loop to
tune in each plot

Architecture | Compensator|

~Design plats configuration

Editor Graphical Tuning | Analysis Plots | Automated Tuning

Flok Available Open/Closed Loop ko Tune Flok Type
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Summary of available Open/Closed loops ko tune:
Loop Mame Loop Descripkion
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Closed Loop 1

Closed Loop - From r ko

Select New Open/Closed Loop to Tune ... Show Design Plat
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b In a design plot, modify the compensator by adding poles, zeros, lead,
and lag, for example. To do this, right-click to add dynamic elements
in the controller structure.

) SISO Design for SIS0 Design Task
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Applied neyy configurstion. Right-click on the plots for design options.

¢ Add a new pole, for example, by clicking the pole location on the plot.
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d Modify the compensator structure by moving the poles, zeros, and other
dynamic elements directly on the plot.

) SISO Design for SISO Design Task o [ 4]
File Edit View Designs Analysis Tools Window Help
« o T
X0 ¥4 S|RM
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7 Export the compensator to the MATLAB workspace for further analysis.

a In the Control and Estimation Tools Manager, select File > Export.

b In the SISO Tool Export dialog box, select the compensator.

¢ Click Export to Workspace.
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SISO Design Tool

In this section...

“Components of the SISO Tool” on page 4-13
“Design Options in the SISO Tool” on page 4-13
“Opening the SISO Design Tool” on page 4-14

“Using the SISO Design Task Node on the Control and Estimation Tools
Manager” on page 4-16

“Importing Models into the SISO Design Tool” on page 4-17
“Feedback Structure” on page 4-20

“Loop Responses” on page 4-22

“Using the Graphical Tuning Window” on page 4-25

Components of the SISO Tool
The SISO Design Tool is made up of the following:

¢ The SISO Design Task in the Control and Estimation Tools Manager,
a user interface (UI) that facilitates the design of compensators for
single-input, single-output feedback loops through a series of interactive
pages (referred to in this document as the SISO Design Task node).

® The Graphical Tuning window, a graphical user interface (GUI) for
displaying and manipulating the Bode, root locus, and Nichols plots for the
controller currently being designed. This window is titled SISO Design
for Design Name.

® The LTI Viewer associated with the SISO Design Task. For instructions
on how to operate the LTI Viewer, see “LTI Viewer” on page 3-7.

Design Options in the SISO Tool

The SISO Design Tool facilitates the design of compensators for single-input,
single-output feedback loops, and lets you iterate rapidly on your designs and
perform the following tasks:

e Manipulate closed-loop dynamics using root locus techniques.
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¢ Shape open-loop Bode responses.

¢ Add compensator poles and zeros.

® Add and tune lead/lag networks and notch filters.

® Inspect closed-loop responses (using the LTI Viewer).
¢ Adjust phase and gain margins.

® Convert models between discrete and continuous time.

® Automate compensator design.

Opening the SISO Design Tool

This section shows how to open the SISO Design Tool with the DC motor
example developed in Chapter 2, “Building Models”

If you have not built the DC motor model, type
load ltiexamples

at the MATLAB prompt. This loads a collection of linear models, including
the DC motor. To open the SISO Design Tool and import the DC motor, type

sisotool(sys_dc)
at the MATLAB prompt.
This command opens both the SISO Design Task node on the Control and

Estimation Tools Manager and the Graphical Tuning window with the root
locus and open-loop Bode diagrams for the DC motor plotted by default.
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.} SIS0 Design for SISO Design Task

File Edit Wiew Designs Analysis Tools Window Help

=10l x|

Mk xe X2z [®RAM N

Root Locus Editor for Open-Loogp 1 (0L1)
T T T T

-20

Open-Loop Bode Editor for Open-Loop 1 (0L1)

-40

-B0

-50

-100

-120

/

G Inf
Fredq: Inf
Stable loop

/

P Inf
Freo: Matd
5 | | | | -180 L L -
Rl ) & E 2 1o 1" o' 10° 10°
Real fxis Frequency (racisec)

1}

Right-click on the plats for more design options.

—

Right-dick in any of
these regions to see
design options.

L This status bar shows

useful tips about how
to use this window
and information
about the status of
your design.

Graphical Tuning Window with the DC Motor Example

Using the SISO Design Task Node on the Control and
Estimation Tools Manager

The SISO Design Task node in the Control and Estimation Tools Manager
contains the following pages for specifying controller design and behavior:

e Architecture:

= Change the feedback structure and label signals and blocks.

= Configure loops for multi-loop design by opening signals to remove the
effects of other feedback loops.

= Import models into your system.
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= Convert the sample time of the system or switch between different
sample times to design different compensators.

e Compensator Editor:
= Directly edit compensator poles, zeros, and gains.

= Add or remove compensator poles and zeros.

Graphical Tuning:
= Configure design plots in the Graphical Tuning window.

= Use design plots to graphically manipulate system response.

Analysis Plots:
= Configure analysis plots in the LTI Viewer.

= Use analysis plots to view the response of open- or closed-loop systems.

Automated Tuning:

= Automatically generate compensators using optimization-based, PID,
internal model control (IMC), linear-quadratic-Gaussian (LQG), or loop
shaping methods.

= Use optimization-based methods that automatically tune the system to
satisfy design requirements (available when you have the Simulink®
Design Optimization™ product).

Importing Models into the SISO Design Tool
If you type

sisotool

at the MATLAB prompt, the Control and Estimation Tools Manager opens
with the SISO Design Task node and an empty Graphical Tuning window.
You can import the DC motor model by clicking System Data on the
Architecture page, shown in the following figure.
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E! Control and Estimation Tools Manager

=10l x|
File Edt Help
= M| o
{k Workspace Architecture I Compensator Ed'rlurl Graphical Tuning | &nalysis Plots | Automated Tun\ngl
=-4] 5150 Desicn Task

Current Architecture:
Cortrol Architecture ... | Modify architecture, lsbels and feedback sighs.
Loop Canfiguration... | Configure additional loop openings for muttiHoop design.
Systern Data ... lrpott data for compensstors and fixed systems.

Sample Time Conversion ...

Change the sample time of the design.

Showw Architecture Store Desigh | Help |

SIS0 Design Task Node.

s L L

This opens the System Data dialog box, which is shown in the following figure.

RI=TE
rImport Maodel
System Data
) 1
H 1
c 1
F 1

Erowse ... |

Ok | Cancel | Help |

To import the DC motor model:



SISO Design Tool

1 Select G and click Browse. The Model Import dialog box opens, as shown

in the following figure.

Model Import x|
Impart model for I G LI
Impart from:

& Workspace

£ MAT File: I Erawzae |

Available Models Type Order
Gel2 tt 4 ;I
Gel3 tt 4
GEervo zpk 4
dizkdrive zpk 10

Impart | Close | Help |

2 Select sys_dc from the Available Models list. Click Import, and then
click Close. You can now see sys_dc loaded into G in the System Data

dialog box.
E! System Data ﬂ
Impart Model
System Data

= = gy=_do =

H 1

C 1

F 1

Ok | Cancel | Help |

3 Click OK. The Graphical Tuning window 1s updated with the DC motor

model, as shown in the following figure.
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.} SIS0 Design for SIS0 Design Task - |EI|1|
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Applied nevy configuration. Right-click on the plots for design options.

Feedback Structure

The SISO Design Tool by default assumes that the compensator is in the
forward path, i.e., that the feedback structure looks like this figure.

—» F |+ G -

H

Default Feedback Structure — Compensator in the Forward Path

In this figure, the lettered boxes represent the following:

e G — plant

¢ H — sensor dynamics
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e F — prefilter

e C — compensator

The default values for F, H, and C are all 1 (you can see this in the System
Data dialog box). Note that this means that by default, the compensator has
unity gain. G contains the DC motor model, sys_dc.

Alternative Feedback Structures
While in the Architecture page, click Control Architecture to open the
Control Architecture dialog box.

) Control Architecture (=] ]
Select Architecture: il dy

Click fo select your gyt

desired configuration.

ﬂﬁ- Signs | Blocks and Signals
Identifier I Sign I
e : & 3

Ok | Cancel | Help |

You can use the Signs and Blocks and Signals panes to change the sign of
the feedback signal into a summing junction and rename blocks and signals
in the diagram respectively. See "Modifying Block Diagram Structure" for
more details.

On any page in the SISO Design Task node on the Control and Estimation

Tools Manager, click Show Architecture to see the current architecture and
a list of the identifiers and names associated with the components.
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Loop Responses

As you select different compensator designs, you may find it convenient to be
able to examine the various loop responses (for example, step or impulse
responses) for a particular design. To view, for example, the closed-loop step
response, click the Analysis Plots tab. This opens the Analysis Plots page
containing the list of available responses, with none initially selected, as
shown in the following figure.
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E! Control and Estimation Tools Manager 1ol =l

File Edt Help

g’:ﬂ|nn

ﬂ Workspace Arch'rlec:lurel Compensator Ed'rlurl Graphical Tuning  Analysis Plots | Automated Tun\ngl
=-4] 3150 Desicn Task —Analysis Plot
- - Diesig History
Flat 1 Plot 2 Plat 3 Flat 4 Plot 5 Flot &
Plot Type I ‘I I More LI INnnE LI INnne LI I Mone LI INnne LI
Contents of Plot
Plots
Responzes
1123456 al
o ol i Closed-Loop rtoy
|| T T |closed-Loop rtou
T T T T | nput Sensttivity
T T T T | output Sensitiviey
R e Moize Sensitivity
Il Y Cpen Loop L
I (C T Compensator C
(T T [prefiter F
o ol ol o 2
T | T sensorH
Add Responses . | Showy Anabysis Plot |
Showy Architecturs | Store Design | Help |
e
[
&

SIS0 Design Task Node.

Select the plot types for each plot in the Analysis Plots group box, and then
select the plots to appear in the Plots list in the Contents of Plots table, as
shown in the following figure.
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E! Control and Estimation Tools Manager 1ol =l

File Edt Help

g’:ﬂ|nn

4 Workspace Arch'rlec:lurel Compensator Ed'rlurl Graphical Tuning  Analysis Plots | Automated Tun\ngl
=-4] 3150 Desicn Task —Analysis Plot
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CE(E(E T Compensator C
(T T |prefiter F
ol ol o 5
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Showy Architecturs | Store Design | Help |
e
[
&

SIS0 Design Task Node.

Analysis Plots Loop Response Selection

After you have selected a plot, the LTI Viewer with the appropriate response(s)
opens. You can also click Show Analysis Plot to open the LTI Viewer.

The following figure shows the resulting plot for the closed-loop step response
of the DC motor.
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) LTI Yiewer for SISO Design Task (=] ]
File Edit ‘Window Help
D& & & E
Step Response
.04
poss [T e ]
003 - —
0025 - —
o
=
£ oozf -
§
0.01s - —
0.0 —
0.005 - —
o 1 1
1] 0.5 1 1.5
Time (zec)
LTI iewer ¥ Real-Time Update

LTl Viewer Showing the Step Response for the DC Motor

As this plot shows, the step response of the DC motor is about 1.5 seconds,
which is too slow for many applications. Also, there is a large steady-state
error. The following sections show how to use Bode diagram techniques for
improving the response time and steady-state error of the DC motor step
response.

As you select different compensator designs, the LTI Viewer associated with
your SISO Design Task will automatically update the response plots you
have chosen for a particular design.

Using the Graphical Tuning Window

The Graphical Tuning window is a graphical user interface (GUI) for
displaying and manipulating the Bode, root locus, and Nichols plots for the
controller currently being designed. Most tasks can be accomplished using
the pages in the SISO Design Task node on the Control and Estimation
Tools Manager. Many of these tasks can also be done in the Graphical Tuning
window, though you will find it easier to use the pages in the SISO Design
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Task node on the Control and Estimation Tools Manager. However, there are
a few tasks, such as adjusting the bandwidth, that can only be done using the
Graphical Tuning window.

This section describes some of the methods for navigating in and manipulating
the appearance of the Graphical Tuning window.

Graphical Tuning Window Display

The Graphical Tuning window shows

e Poles as x’s
® Zeros as 0’s

¢ Gain and phase margins (by default) in the lower-left corners of the Bode
magnitude and phase plots

Changing Units on a Plot

The SISO Design Tool provides editors for setting plot options in the Graphical
Tuning window. If you want, for example, to change the frequency units on
all the Bode plots created in the SISO Design Tool from rad/s to Hertz, select
SISO Tool Preferences from the Edit menu in the SISO Design Task
node on the Control and Estimation Tools Manager, as shown next.



SISO Design Tool

E! Control and Estimation Tools Manager o =] |
File |Edt Help

~

= Undo Change Configuration Ctr+Z
r Redo CErl+Y

Dresign Histary

ure I Compensator Ed'rlUrI Graphical Tuning | Analysis Plots | Automated Tun\ngl

Cuent Architecture:

Cortral Architecture Modify architecture, labelz and feedback signs

Loop Configurstion. .. Configure additional loop openings for muti-loop design.

System Data ... Impoit data for compensators and fixed systems.

Satnple Time Conversion ..

Change the sample time of the desigh.

Showr Architecture Store Design | Help |

SISO Tool Preferences

NLEIEID

This opens the SISO Tool Preferences dialog box.

SISO Tool Preferences 10l =|
Units | Style I Optiohs I Line Colars I

Units

Freguency in Irad.l’sec: LI using Ilog scale LI

Magnitude in db -

Phase in Idegrees - I

Ok Cancel Help Apply
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Use the options on the Units page to make the change. This unit change
persists for the entire session.

For more information about property and preference settings, see
Customization.

Right-Click Menus

The SISO Design Tool has right-click menus available in any of the plot
regions. Open the Bode magnitude menu by right-clicking your mouse in the
white space of the Bode magnitude plot. The following menu appears.

fdd PalefZera ]
Deleke Pole/Zero
Edit Compensator.. .

Select Compensator b

Show ]
[esign Requirements Pk
i

Full Yigw

Froperties, ..

Right-Click Menu for the Bode Magnitude Plot

Although the menus for each plot generally contain the same options, there
are some options specific to each plot type; for example, where the Closed-Loop
Bode Editor right-click menu has a Select Compensator option, the
Open-Loop Bode Editor right-click menu has a Gain Target option instead.

The right-click menus contain numerous features. The DC motor example
uses many of the available features; for a complete discussion of the right-click
menus, see the help for the SISO Design Tool in "Using the SISO Design Tool
and the LTI Viewer."



Bode Diagram Design

Bode Diagram Design

In this section...

“What is Bode Diagram Design?” on page 4-29
“Example: DC Motor” on page 4-29

“Adjusting the Compensator Gain” on page 4-30
“Adjusting the Bandwidth” on page 4-31

“Adding an Integrator” on page 4-33

“Adding a Lead Network” on page 4-37

“Moving Compensator Poles and Zeros” on page 4-42
“Adding a Notch Filter” on page 4-45

“Modifying a Prefilter” on page 4-50

What is Bode Diagram Design?

One technique for compensator design is to work with Bode diagrams of the
open-loop response (loop shaping).

Using Bode diagrams, you can

® Design to gain and phase margin specifications
® Adjust the bandwidth

® Add notch filters for disturbance rejection

Example: DC Motor

The following sections use the DC motor example to show how create a
compensator using Bode diagram design techniques. From “SISO Example:
The DC Motor” on page 2-3, the transfer function of the DC motor is

Transfer function:
1.5

s"2 + 14 s + 40.02
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For this example, the design criteria are as follows:

® Rise time of less than 0.5 second

Steady-state error of less than 5%
Overshoot of less than 10%

® Gain margin greater than 20 dB

Phase margin greater than 40 degrees

Adjusting the Compensator Gain

The LTI Viewer Showing the Step Response for the DC Motor on page 4-25,
shows that the closed-loop step response is too slow. The simplest approach to
speeding up the response is to increase the gain of the compensator.

To increase the gain:

1 Click the Compensator Editor tab to open the Compensator Editor
page.

2 Select C from the compensator selection list.

3 In the text box to the right of the equal sign in the Compensator area,
enter 38 and press Enter.
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E! Control and Estimation Tools Manager i =] 5|
File Edt Help
S Mo o
ﬂ Workspace Architecture  Compensator Ecitor I Graphical Tuning | Analysis Plots | Automated Tuning
=-4] 3150 Desicn Task
- - Diesig History e
[c =]-Fd
PolefZero | Paratmeter I
i Dyramics i Edit Selected Dynamics |

Select & single row o edit values

Right-click to add or delste polesizeros

Showr Architecture Store Design | Help |

s 1

Adjusting Compensator Gain on the Compensator Editor Page

The SISO Design Tool calculates the compensator gain, and Bode and root
locus graphs in the Graphical Tuning window are updated.

Alternatively, you can set the gain in the Graphical Tuning window by
grabbing the Bode magnitude line and dragging it upward. The gain and poles
change as the closed-loop set point is recomputed, and the new compensator
value is updated in the Compensator Editor page.

Adjusting the Bandwidth

Because the design requirements include a 0.5-second rise time, try setting
the gain so that the DC crossover frequency is about 3 rad/s. The rationale for
setting the bandwidth to 3 rad/s is that, to a first-order approximation, this
should correspond to about a 0.33-second time constant.
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To make the crossover easier to see, select Grid from the right-click menu.
This creates a grid for the Bode magnitude plot. Left-click the Bode magnitude
plot and drag the curve until you see the curve crossing over the 0 dB line (on
the y axis) at 3 rad/s. This changes both the SISO Design Tool display and
the LTI Viewer step response.

For a crossover at 3 rad/s, the compensator gain should be about 38. By
default, the Graphical Tuning window shows gain and phase margin
information in the lower-left corners of the Bode diagrams. In the Bode
magnitude plot, it also tells you if your closed-loop system is stable or unstable.

This figure shows the Graphical Tuning window.

.} SIS0 Design for SISO Design Task = |EI|1|

File Edit Wiew Designs Analysis Tools ‘Window Help

Mk xo X2 |[®AQMNN

Root Locus Editor for Open-Loop 1 (OL1) Open-Loop Bode Editor for Open-Loop 1 (00L1)
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Graphical Tuning
window recakulates
the compensator gain
as you move the hand.

u Pl o

20 |-

40 |-

B0 PG I
-1 : : . : Freoq: Inf

-10 -3 -6 -4 -2 1]
) Stable loop
Bode Editar for Closed-Loop 1 (CL1) .

Increasing the

com pensator gain

changed the phase

margin to 119" The
™ Graphical Tuning

window adds a brown

stem to show the new

50 1 as|-

100 L L L aot- o
1}

IEE

_an b ! N
P 119 deg

Freq: 3.55 radisec E:::: I'III .
-180 . . -180 = phase margin.
107 10° 10’ 10° ST 10° 10’ 10° 10°
Frequency (radizec) Frequency (radizec)

Open-loop magnitude plat.
Left click and move this curve up or down to adjust the gain of c.

Adjusting Bandwidth in the Graphical Tuning Window

This plot shows the associated closed-loop step response in the LTI Viewer.
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) LTI Yiewer for SISO Design Task (=] ]
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Closed-Loop Step Response for the DC Motor with a Compensator Gain = 38

The step response shows that the steady-state error and rise time have
improved somewhat, but you must design a more sophisticated controller
to meet all the design specifications, in particular, the steady-state error
requirement.

Adding an Integrator

One way to eliminate steady-state error is to add an integrator. To add an
integrator:

1 Click the Compensator Editor tab to open the Compensator Editor
page.

2 Right-click anywhere in the Dynamics table for the right-click menu, and
then select Add Pole/Zero > Integrator.

The following figures show this process.
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Adding an Integrator in the Dynamics Table
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Editable Integrator Parameters
Notice adding the integrator changed the crossover frequency of the system.
Readjust the compensator gain in the Compensator Editor page to bring

the crossover back to 3 rad/s; the gain should be 99.

After you have added the integrator and readjusted the compensator gain, the
Graphical Tuning window shows a red ‘x’ at the origin of the root locus plot.
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Integrator on the Root Locus Plot

The following figure shows the closed-loop step response.
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Step Response for the DC Motor with an Integrator in the Compensator

Use the right-click menu to show the peak response and rise time (listed
under the Characteristics). The step response is settling around 1, which
satisfies the steady-state error requirement. This is because the integrator
forces the system to zero steady-state error. The figure shows, however, that
the peak response is 1.3, or about 30% overshoot, and that the rise time is
roughly 0.4 second. So a compensator consisting of an integrator and a gain
1s not enough to satisfy the design requirements, which require that the
overshoot be less than 10%.

Adding a Lead Network

Part of the design requirements is a gain margin of 20 dB or greater and a
phase margin of 40° or more. In the current compensator design, the gain
margin is 11.5 dB and the phase margin is 38.1°, both of which fail to meet the
design requirements. The rise time needs to be shortened while improving
the stability margins. One approach is to increase the gain to speed up the
response, but the system is already underdamped, and increasing the gain
will decrease the stability margin as well. You might try experimenting with
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the compensator gain to verify this. The only option left is to add dynamics to

the compensator.

One possible solution is to add a lead network to the compensator. To add

the lead network:

1 Click the Compensator Editor tab to open the Compensator Editor

page.

2 In the Dynamics table, right-click and then select Add Pole/Zero > Lead.

The following figures show the process of adding a lead network to your

controller.
) control and Estimation Tools Manager =101 =]
File Edt Help
= H| o o
Q« Wiorkspace Architecture  Compensator Ecitor I Graphical Tuning | &nalysis Plots | Automated Tuning
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[ =l-Fe =
H
PolefZera | Paratmeter I
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Type I Location I Datrping I Freguency |
Integrator |0 -1 o
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Delete PolefZero Complex Pole
Inkeqgrator Select a single row to edit values
Real Zero
Complex Zero
Differentiator
Lag !
Right-click to add or delste polesizeros
Maokch
Showr Architecture | Store Design | Help |
E
[
v

Adding a Lead Network to the DC Motor Compensator on the Compensator
Editor Page
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Right-click to add or delete poles/zeros
Show Architecture Store Design | Help |

NI

Lead Network Added

Editable fields are shown in the Edit Selected Dynamics group box (right

side of page) when an item in the Dynamics table has been selected, as
shown in the following figure.
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For this example, change Real Zero to -7.38 and change Real Pole to -11.1.

You can also add a lead network using the Graphical Tuning window.
Right-click in the Bode graph, select Add Pole/Zero > Lead, place the X’
on the plot where you want to add the lead network, and then left-click to

place it. The Compensator Editor page is updated to include the new lead
network in the Dynamics table.

Your Graphical Tuning window and LTI Viewer plots should now look similar
to these.
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Root Locus, Bode, and Step Response Plots for the DC Motor with a Lead

Network
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The Step Response plot shows that the rise time is now about 0.4 second and
peak response is 1.24 rad/s (i.e., the overshoot is about 25%). Although the rise
time meets the requirement, the overshoot is still too large, and the stability
margins are still unacceptable, so you must tune the lead parameters.

Moving Compensator Poles and Zeros

To improve the response speed, edit the selected dynamics for the lead
network in the Edit Selected Dynamics group box on the Compensator
Editor page.

1 Change the value of the lead network zero (Real Zero) to move it closer to
the left-most (slowest) pole of the DC motor plant (denoted by a blue ‘x’).

2 Change the value of the lead network pole (Real Pole) to move it to the
right. Notice how the gain margin increases (as shown in the Graphical
Tuning window) as you do this.
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As you tune these parameters, look at the LTI Viewer. You will see the
closed-loop step response alter with each parameter change you make.
The following figure shows the final values for a design that meets the
specifications.
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Graphical Tuning Window with Final Design Parameters for the DC Motor
Compensator

The values for this final design are as follows:

e Poles at 0 and -28
® Zero at -4.3
e Gain = 84
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Enter these values directly in the Edit Selected Dynamics group box in the
Compensator Editor page, shown as follows (Integrator is already set to 0).

E! Control and Estimation Tools Manager
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Entering Final Design Parameters on the Compensator Editor Page

The following figure shows the step response for the final compensator design.
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Step Response for the Final Compensator Design

In the LTI Viewer’s right-click menu, select Characteristics > Peak
Response and Characteristics > Rise Time to show the peak response and
rise time, respectively. Hover the mouse over the blue dots to show the data
markers. The step response shows that the rise time i1s 0.45 second, and the
peak amplitude is 1.03 rad/s, or an overshoot of 3%. These results meet the

design specifications.

Adding a Notch Filter

If you know that you have disturbances to your system at a particular
frequency, you can use a notch filter to attenuate the gain of the system at
that frequency. To add a notch filter, click the Compensator Editor tab to
open the Compensator Editor page. Right-click in the Dynamics table and
select Add Pole/Zero > Notch, as shown next.
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Adding a Notch Filter with the Dynamics Right-Click Menu

Default values for the filter are supplied, as shown next.
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Notch Filter Default Values

The following figure shows the result in the Graphical Tuning window.
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Notch Filter Added to the DC Motor Compensator

To see the notch filter parameters in more detail, click the Zoom In

icon on the Graphical Tuning window. In the Open-Loop Bode Editor, press
the left mouse button and drag your mouse to draw a box around the notch

filter. When you release the mouse, the Graphical Tuning window will zoom
in on the selected region.

To understand how adjusting the notch filter parameters affects the filter,
consider the notch filter transfer function.

2 2
s+ 20w s+w,

]

2
s+ 20w, 8+ w,
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The three adjustable parameters are §,, §,, and ®_. The ratio of {,/§, sets the
depth of the notch, and @, is the natural frequency of the notch.

This diagram shows how moving the red and black diamonds changes these
parameters, and hence the transfer function of the notch filter.

— = st E for & o/E ronstant [i.e., odjust the width of the
notech while holding the notch depth comstant).

Adjust £5,/57 [depth of the notch).

A Close Look at Notch Filter Parameters
In the Dynamics table on the Compensator Editor page, select the row

containing the newly added notch filter. The editable fields appear in the Edit
Selected Dynamics group box, as shown next.
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Editing Notch Filter Parameters

Modifying a Prefilter

You can use the SISO Design Tool to modify the prefilter in your design.

Typical prefilter applications include:

¢ Achieving (near) feedforward tracking to reduce load on the feedback loop

(when stability margins are poor)

¢ Filtering out high frequency content in the command (reference) signal to
limit overshoot or to avoid exciting resonant modes of the plant

A common prefilter is a simple lowpass filter that reduces noise in the input

signal.
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Open the Bode diagram for the prefilter by opening the right-click menu in
the Closed-Loop Bode Editor in the Graphical Tuning window, and then
selecting Select Compensators > F(F).
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Selecting the Prefilter in the Graphical Tuning Window

For clarity, the previous figure does not show the open-loop Bode diagram for
the compensator (C). To remove the Bode diagram from the Graphical Tuning
window, go to the SISO Design Task node on the Control and Estimation
Tools Manager, click the Graphical Tuning tab, and for Plot 2, Open Loop 1,
select Plot type None.
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Prefilter Bode Diagram

If you haven’t imported a prefilter, the default is a unity gain. You can add
poles and zeros and adjust the gain using the same methods as you did when
designing the compensator (C) on the Compensator Editor page.

A quick way to create a lowpass roll-off filter is to add a pair of complex

4-52

poles. To do this, first click the Compensator Editor tab and change

the compensator to F. Right-click in the Dynamics table and select Add
Pole/Zero > Complex Pole. Select this line to show the editable parameters
in the Edit Selected Dynamics group box. For this example, try to place
the poles at about 50 rad/s. The following figure shows the poles added to
the prefilter Bode diagram.
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Adding a Complex Pair of Poles to the Prefilter Bode Diagram

By default, the damping ratio of the complex pair is 1.0, which means that
there are two real-valued poles at about -50 rad/s. The green curve, which
represents the prefilter Bode response, shows the -3 dB point for the roll-off
is at about 50 rad/s. The magenta curve, which represents the closed-loop
response from the prefilter to the plant output, shows that after the -3 dB
point, the closed-loop gain rolls off at -40 dB/decade to provide some noise
disturbance rejection.

Importing a Prefilter

As an alternative approach, you can design a prefilter using the Control
System Toolbox commands like ss or tf and then import the design directly
into the prefilter. For example, to create the lowpass filter using zpk, try

prefilt=zpk([],[-35 + 35i, -35 - 35i],1)
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and import prefilt by clicking System Data on the Architecture page.
This opens the System Data dialog box. Click Browse to open the Model
Import dialog box, as shown next.

x

Impart Model

System Drata

= 3ys_do =
1
= currert valug =
= prefit =

Model Import x|

Impart model for I F LI

T O[T (o

% Impart fram:

& Workspace

£ MAT File: I Erawzae |

Available Models Type Order
Gel3 tt 4 ;I
Gzervo 4
diskdrive 10

Impart | Close | Help |

Importing a Prefilter

Select prefilt from the Available Models list and click Import to import
the prefilter model. Click Close to close the Import Model dialog box. After
you have imported the prefilter model, you can modify it using the same
methods as described in this chapter for compensator design.
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Root Locus Design

In this section...

“What is Root Locus Design?” on page 4-55

“Example: Electrohydraulic Servomechanism” on page 4-56
“Changing the Compensator Gain” on page 4-62

“Adding Poles and Zeros to the Compensator” on page 4-65
“Editing Compensator Pole and Zero Locations” on page 4-70
“Viewing Damping Ratios” on page 4-74

“Exporting the Compensator and Models” on page 4-76

“Storing and Retrieving Intermediate Designs” on page 4-78

What is Root Locus Design?

A common technique for meeting design criteria is root locus design. This
approach involves iterating on a design by manipulating the compensator
gain, poles, and zeros in the root locus diagram.

As system parameter k varies over a continuous range of values, the root locus
diagram shows the trajectories of the closed-loop poles of the feedback system.
Typically, the root locus method is used to tune the loop gain of a SISO control
system by specifying a designed set of closed-loop pole locations.

Consider, for example, the tracking loop

+
r () | P(s) -y

E |la— ! His) |ag— |
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where P(s)is the plant, H (s is the sensor dynamics, and % is a scalar gain to
be adjusted. The closed-loop poles are the roots of

g(s)=1+k P(s)H(s)

The root locus technique consists of plotting the closed-loop pole trajectories
in the complex plane as £ varies. You can use this plot to identify the gain
value associated with a desired set of closed-loop poles.

The DC motor design example focused on the Bode diagram feature of the
SISO Design Tool. Each of the design options available on the Bode diagram
side of the tool have a counterpart on the root locus side. To demonstrate
these techniques, this example presents an electrohydraulic servomechanism.

The SISO Design Tool’s root locus and Bode diagram design tools provide
complementary perspectives on the same design issues; each perspective
offers insight into the design process. Because the SISO Design Tool shows
both root locus and Bode diagrams, you can also choose to combine elements
of both perspectives in making your design decisions.

Example: Electrohydraulic Servomechanism

A simple version of an electrohydraulic servomechanism model consists of

A push-pull amplifier (a pair of electromagnets)

A sliding spool in a vessel of high-pressure hydraulic fluid

Valve openings in the vessel to allow for fluid to flow

A central chamber with a piston-driven ram to deliver force to a load

® A symmetrical fluid return vessel

This figure shows a schematic of this servomechanism.
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Return

il
Amplitier

Pressure

Electrohydraulic Servomechanism

Push-Pull
Amplifier

ﬁ Piston-driven ram

The force on the spool is proportional to the current in the electromagnet coil.
As the spool moves, the valve opens, allowing the high-pressure hydraulic
fluid to flow through the chamber. The moving fluid forces the piston to move
in the opposite direction of the spool. Control System Dynamics, by R. N.
Clark, (Cambridge University Press, 1996) derives linearized models for the
electromagnetic amplifier, the valve spool dynamics, and the ram dynamics; it

also provides a detailed description of this type of servomechanism.

If you want to use this servomechanism for position control, you can use
the input voltage to the electromagnet to control the ram position. When
measurements of the ram position are available, you can use feedback for the
ram position control, as shown in the following figure.

Reference

Position
p..o w Cis)

Applied
Voltage

Compensator

Gservols

Ram
Position

Plant

Feedback Control Structure for an Electrohydraulic Servomechanism
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Your task is to design the compensator, C(s).

Plant Transfer Function
If you have not already done so, type

load ltiexamples

to load a collection of linear models that include Gservo, which is a linearized
plant transfer function for the electrohydraulic position control mechanism.
Typing Gservo at the MATLAB prompt opens the servomechanism (plant)
transfer function.

Gservo

Zero/pole/gain from input "Voltage" to output "Ram position":
40000000

s (s+250) (s"2 + 40s + 9e004)

Design Specifications

For this example, you want to design a controller so that the step response of
the closed-loop system meets the following specifications:

® The 2% settling time is less than 0.05 second.

® The maximum overshoot is less than 5%.

The remainder of this section discusses how to use the SISO Design Tool to
design a controller to meet these specifications.

Opening the SISO Design Tool
Open the SISO Design Tool and import the model by typing

sisotool(Gservo)

at the MATLAB prompt. This opens the SISO Design Task node in the
Control and Estimation Tools Manager and the Graphical Tuning window
with the servomechanism plant imported.
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Right-click on the plats for more design options.

Graphical Tuning Window Showing the Root Locus and Bode Plots for the
Electrohydraulic Servomechanism Plant

Zooming
Click the Zoom In

icon in the Graphical Tuning window. Press and hold the mouse’s left button
and drag the mouse to select a region for zooming. For this example, reduce
the root locus region to about -500 to 500 in both the x- and y-axes. This figure
illustrates the zooming in process.
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Right-click on the plots for more design options.

Zooming In on a Region in the Root Locus Plot

Hold the left mouse
button down and drag
the mouse toselect a
rectangular region for
zooming in. Whe n you
release the mouse
button, the Graphical
Tuning window replots
the root locus with the
new axis boundaries.

To undo the zoom,
right-click in the Root
Locus Editor graph
and select Reset to
Original View from
the pop-up menu.

When you are done
zooming, click the

Zoom In kon again
to furn zooming off.

As in the DC motor example, click the Analysis Plots tab to set up loop
responses. Select Plot Type Step for Plot 1, then select plot 1 for Closed-Loop

r to y, shown as follows.
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For more information about the Analysis Plots page, see Analysis Plots in
"Using the SISO Design Tool and LTI Viewer."

Selecting the plot for Closed-Loop r to y opens the associated LTI Viewer.

Your LTI Viewer should look like the following figure.
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LTI Viewer for the Electrohydraulic Servomechanism

The step response plot shows that the rise time is on the order of 2 seconds,
which 1s much too slow given the system requirements. The following sections
describe how to use frequency design techniques in the SISO Design Tool

to design a compensator that meets the requirements specified in “Design
Specifications” on page 4-58.

Changing the Compensator Gain

The simplest thing to do is change the compensator gain, which by default
is unity. You can change the gain by entering the value directly in the
Compensator Editor page.

The following figure shows this procedure.
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Changing the Compensator Gain in the Root Locus Plot with the Compensator

Editor Page

Enter the compensator gain in the text box to the right of the equal sign as

shown in the previous figure. The Graphical Tuning window automatically
replots the graphs with the new gain.

Experiment with different gains and view the closed-loop response in the

associated LTI Viewer.

Alternatively, you can change the gain by grabbing the red squares on the root
locus plot in the Graphical Tuning window and moving them along the curve.
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Closed-Loop Response

Change the gain to 20 by editing the text box next to the equal sign on the
Compensator Editor page. Notice that the locations of the closed-loop poles
on the root locus are recalculated for the new gain.

This figure shows the associated closed-loop step response for the gain of 20.
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Step Response with the Settling Time for C(s) = 20

In the LTI Viewer’s right-click menu, select Characteristics > Settling
Time to show the settling for this response. This closed-loop response does
not meet the desired settling time requirement (0.05 seconds or less) and
exhibits unwanted ringing. “Adding Poles and Zeros to the Compensator” on
page 4-65 shows how to design a compensator so that you meet the required
specifications.
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Adding Poles and Zeros to the Compensator

You may have noticed that increasing the gain makes the system
under-damped. Further increases force the system into instability, so meeting
the design requirements with only a gain in the compensator is not possible.

There are three sets of parameters that specify the compensator: poles, zeros,
and gain. After you have selected the gain, you can add poles or zeros to
the compensator.

Adding Poles to the Compensator

You can add complex poles on the Compensator Editor page. Click the
Compensator Editor tab, make sure C is selected, and then right click

in the Dynamics table. Select Add Pole/Zero > Complex Pole. Use the
Edit Selected Dynamics group box to modify pole parameters, as shown in
the following figure. For more about entering pole parameters directly, see
“Editing Compensator Pole and Zero Locations” on page 4-70.
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Adding a Complex Pair of Poles to the Compensator on the Compensator
Editor Page

You can also add a complex pole pair directly on the root locus plot using the
Graphical Tuning window. Right-click in the root locus plot and select Add
Pole/Zero > Complex Pole. Click in the root locus plot region where you
want to add one of the complex poles.

Complex poles added in this manner are automatically added to the
Dynamics table in the Compensator Editor page.

After you have added the complex pair of poles, the LTI Viewer response plots
change and both the root locus and Bode plots show the new poles.

This figure shows the Graphical Tuning window with the new poles added.
For clarity, you may want to zoom out further, as was done here.
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Result of Adding a Complex Pair of Poles to the Compensator

Adding Zeros to the Compensator

You can add zeros in the Dynamics table on the Compensator Editor page
or directly on the Root Locus plot in the Graphical Tuning window.

To add the zeros using the Compensator Editor page, click the
Compensator Editor tab, make sure C is selected, and then right click

in the Dynamics table. Select Add Pole/Zero > Complex Zero. Use the
Edit Selected Dynamics group box to modify zero parameters, as shown.
For more about entering zero parameters directly, see “Editing Compensator
Pole and Zero Locations” on page 4-70.
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Adding Complex Zeros to the Compensator on the Compensator Editor Page

You can also add complex zeros directly on the root locus plot using the

Graphical Tuning window by right-clicking in the root locus plot, selecting
Add Pole/Zero > Complex Zero, and then clicking in the root locus plot
region where you want to add one of the zeros.

Complex zeros added in this manner are automatically added to the
Dynamics table on the Compensator Editor page.

After you have added the complex zeros, the LTI Viewer response plots change
and both the root locus and Bode plots show the new zeros.
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Electrohydraulic Servomechanism Example with Complex Zeros Added

If your step response is unstable, lower the gain by grabbing a red box in the
right-side plane and moving it into the left-side plane. In this example, the
resulting step response is stable, but it still doesn’t meet the design criteria
since the 2% settling time is greater than 0.05 second.

As you can see, the compensator design process can involve some trial and
error. You can try dragging the compensator poles, compensator zeros, or the
closed-loop poles around the root locus until you meet the design criteria.

“Editing Compensator Pole and Zero Locations” on page 4-70, shows you
how to modify the placement of poles and zeros by specifying their numerical
values on the Compensator Editor page. It also presents a solution that
meets the design specifications for the servomechanism example.

Editing Compensator Pole and Zero Locations

A quick way to change poles and zeros is simply to grab them with your
mouse and move them around the root locus plot region. If you want to specify
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precise numerical values, however, you should use the Compensator Editor
page in the SISO Design Task node on the Control and Estimation Tools
Manager to change the gain value and the pole and zero locations of your
compensator, as shown.
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Using the Compensator Editor Page to Add, Delete, and Move Compensator
Poles and Zeros

You can use the Compensator Editor page to

Add compensator poles and zeros.

Delete compensator poles and zeros.

Edit the compensator gain.

Edit the locations of compensator poles and zeros.
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Adding Compensator Poles and Zeros
To add compensator poles or zeros:

1 Select the compensator (in this example, C) in the list box to the left of
the equal sign.

2 Right-click in the Dynamics table for the pop-up menu.

3 From the pop-up menu, select Add Pole/Zero > Complex Pole or Add
Pole/Zero > Complex Zero.

4 Use the Edit Selected Dynamics group box to modify pole or zero
parameters.

Deleting Compensator Poles and Zeros
To delete compensator poles or zeros:

1 Select the compensator (in this example, C) in the list box to the left of
the equal sign.

2 Select the pole or zero in the Dynamics table that you want to delete.

3 Right-click and select Delete Pole/Zero from the pop-up menu.

Editing Gain, Poles, and Zeros
To edit compensator gain:

1 Select the compensator to edit in the list box to the left of the equal sign
in the Compensator area.

2 Enter the gain value in the text box to the right of the equal sign in the
Compensator area.

To edit pole and zero locations:
1 Select the pole or zero you want to edit in the Dynamics table.

2 Change current values in the Edit Selected Dynamics group box.
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For this example, edit the poles to be at — 110 + 140i and the zeros at
— 70 4 270i. Set the compensator gain to 23.3.

Your Graphical Tuning window now looks like this.
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Graphical Tuning Window with the Final Values for the Electrohydraulic
Servomechanism Design Example

To see that this design meets the design requirements, look at the step
response of the closed-loop system.
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Closed-Loop Step Response for the Final Design of the Electrohydraulic
Servomechanism Example

The step response looks good. The settling time is less than 0.05 second, and
the overshoot is less than 5%. You have met the design specifications.

Viewing Damping Ratios

The Graphical Tuning window provides design requirements that can make it
easier to meet design specifications. If you want to place, for example, a pair
of complex poles on your diagram at a particular damping ratio, select Design
Requirements > New from the right-click menu in the root locus graph.

This opens the New Design Requirement dialog box.
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Applying damping ratio requirements to the root locus plot results in a pair of

shaded rays at the desired slope, as this figure shows.
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Try moving the complex pair of poles you added to the design so that they are
on the 0.707 damping ratio line. You can experiment with different damping
ratios to see the effect on the design.

If you want to change the damping ratio, select Design Requirements >
Edit from the right-click menu. This opens the Edit Design Requirements
dialog box.

Dezigh recuirement paramster

Darmping ratio > |u.m?

Cloze I Help

Specify the new damping ratio requirement in this dialog box.

An alternate way to adjust a requirement is to left-click the requirement itself
to select it. Two black squares appear on the requirement when it is selected.
You can then drag it with your mouse anywhere in the plot region.

If you want to add a different set of requirements, for example, a settling time
requirement, again select Design Requirements > New from the right-click
menu to open the New Requirements dialog box and choose Settling time
from the pull-down menu. You can have multiple types of design requirements
in one plot, or more than one instance of any type.

The types of requirements available depend on which view you use for
your design. See Design Requirements for a description of all the design
requirement options available in the SISO Design Tool.

Exporting the Compensator and Models

Now that you have successfully designed your compensator, you may want
to save your design parameters for future implementation. You can do this
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by selecting Export from the File menu on the SISO Design Task node on
the Control and Estimation Tools Manager or from the File menu on the
Graphical Tuning window. Both methods open the SISO Tool Export dialog

box.

«): SIS0 Tool Export

Select design: |[[§

Select models to export:

Componerit

Prefiter F

F

Export Az

=10l x|

Export to Workspace |

Plarit G Gservo

Sensor H H

Closed-Loop rto y T_r2y

Closed-Loop rtou T_r2u —

Input Sensitivity S_in

Output Sensitivity S_out

Moize Sensitivity S_noize Cancel |
Open-Loop L L

MIMO Closed Loop T | e |
4 | IO

Double-click any cell in the Export As
column to edit the name for export.

The list of models that you see includes the components for all of your designs.
You may view the components for a particular design by selecting the design

name from the Select design pull-down list.

The variables listed in the Export As column are either previously named
by you (in the System Data dialog box) or have default names. To export
your compensator to the workspace:

1 Select Compensator Cin the Component column. If you want to change
the export name, double-click in the cell for Compensator C.

2 Click Export to Workspace.

If you go to the MATLAB prompt and type

who

the compensator is now in the workspace, in the variable named C.

Type
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C
to see that this variable is stored in zpk format.

To select multiple components, use the Shift key if they are all adjacent and
the Ctrl key if they are not.

Clicking Export to Disk opens the Export to Disk dialog box.

Export to Disk EHE

Save ir: Ialemp j gI IE-T

File name: Gzervo.mat Save

[ s |
Cancel |

Save as tpe: [IENRTERNEY

You can save your models as MAT-files in any directory you want. The default
name for the MAT-file is the name of your original model; you can change
the name to anything you want. If you save multiple components, they are
stored in a single MAT-file.

Storing and Retrieving Intermediate Designs

You can store and retrieve intermediate compensators while you iterate on
your compensator design. To store intermediate designs, click the Design
History node or Store Design, both located on the SISO Design Task node
in the Control and Estimation Tools Manager.

Alternatively, you can select Store/Retrieve from the Designs menu in

the Graphical Tuning window. Using either method, the following Design
History page opens.
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E! Control and Estimation Tools Manager o =] [
File Edt Help
= || o o
4\ Wiorkspace
E---{D SIS0 Design Task Design Descriation
Delete Store Design Retrieve Design |
e
[
Mairtain your previous desigh shapshots: i

If you have any intermediate designs already stored, they will appear on
the Design History page.

Click Store Design to save the current design with the default name Design;
the suffix increments when you store additional compensators without
renaming them. You can rename the design by right-clicking the name under
the node and selecting Rename.

To retrieve intermediate designs, again click the Design History node or
select Store/Retrieve from the Designs menu. From the Design History
page, select the design to retrieve, and then click Retrieve Design, as shown
next.
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Design History Page Listing Current Designs

The Graphical Tuning window automatically reverts to the selected

compensator design.

Click any design name in the Design History to view a snapshot summary of

the design, as shown in the following figure.
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Return to the compensator list by clicking the Design History node.

You can delete an intermediate design by selecting it from the Design
History page and clicking Delete.
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Nichols Plot Design

In this section...
“What is Nichols Plot Design?” on page 4-82
“DC Motor Example” on page 4-82

“Opening a Nichols Plot” on page 4-83
“Adjusting the Compensator Gain” on page 4-84
“Adding an Integrator” on page 4-87

“Adding a Lead Network” on page 4-89

What is Nichols Plot Design?

An alternative method for designing compensators is to use the Nichols
plot, which combines gain and phase information in a single plot. The
combination of the two is useful when you are designing to gain and phase
margin specifications.

You can design compensators with the SISO Design Tool by using Nichols plot
techniques. This section repeats the DC motor compensator design presented
in “Example: DC Motor” on page 4-29, only this time the focus is on Nichols
plot techniques. The design strategy, however, is the same.

1 Adjust the compensator gain to improve the rise time.
2 Add an integrator to eliminate steady-state error.

3 Add a lead network to further improve the rise time while minimizing
overshoot.

DC Motor Example

From “SISO Example: The DC Motor” on page 2-3, the transfer function of
the DC motor is

Transfer function:
1.5

s"2 + 14 s + 40.02
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This example uses the design criteria specified in “Design Specifications”
on page 4-58:

® Rise time of less than 0.5 second

Steady-state error of less than 5%
Overshoot of less than 10%

¢ Gain margin greater than 20 dB

Phase margin greater than 40 degrees

Opening a Nichols Plot

To open the SISO Design Tool with a Bode diagram and a Nichols plot, use
these commands:

load ltiexamples
sisotool({'bode', 'nichols'},sys_dc)

The SISO Design Task node on the Control and Estimation Tools Manager
opens and the Graphical Tuning window with sys_dc opens.
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Right-click on the plats for more design options.

Graphical Tuning Window with a Bode Diagram and a Nichols Plot

Adjusting the Compensator Gain

You can adjust the compensator gain by entering a value in the Compensator
Editor page.

1 Click the Compensator Editor tab to open the Compensator Editor
page.

2 Select C from the compensator selection list.

3 In the text box to the right of the equal sign in the Compensator area,
enter the gain amount and press Enter.
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Adjusting Compensator Gain in the Compensator Editor Page
In this example, the new gain is 112.

You can also adjust the compensator gain in the Graphical Tuning window by
moving the Nichols curve up and down with your mouse. To do this, place
your mouse over the curve. The cursor turns into a hand. Left-click and move
the curve up to increase the gain. When you adjust the gain in this manner,
the compensator gain is automatically updated in the Compensator Editor
page.

Click the Analysis Plots tab to set the analysis plots. Select Plot Type
Step for Plot 1, and then select plot 1 for Closed-Loop r to y, as shown in
the following figure, to open a linked LTI Viewer with the closed-loop step
response from reference signal r to output signal y.
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LTI Viewer Step Response for Compensator Gain = 112

The rise time is quite fast, about 0.15 second, but the overshoot is 18.4%
and the steady-state is about 0.82.

Adding an Integrator

One approach to eliminating the steady-state error is to add an integrator.
To add an integrator:

1 Click the Compensator Editor tab to open the Compensator Editor
page.

2 Right-click in the Dynamics table and select Add Pole/Zero >
Integrator.

This figure shows the process.
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Adding an Integrator in the Dynamics Table

You can also add an integrator by selecting Add Pole/Zero > Integrator
from the right-click menu in the Graphical Tuning window. When you add the
integrator in this manner, it is automatically added to the Dynamics table
on the Compensator Editor page.

Adding an integrator changes the gain margin from infinity to 10.5 dB. Since
the gain and phase margins are now both finite, the Nichols plot shows a

vertical line for the gain margin and a horizontal line for the phase margin.

The linked LTI Viewer automatically updates to show the new response.
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Step Response for a Compensator Consisting of a Gain and an Integrator

The steady-state value is now 1, which means the steady-state error has been
eliminated, but the overshoot is 34% and the rise time is about 0.7 second.
You must do more work to create a good design.

Adding a Lead Network

Improving the rise time requires that you increase the compensator gain, but
increasing the gain further deteriorates the gain and phase margins while
increasing the overshoot. You need to add a lead network to selectively raise
the gain about the frequency crossover. To add the lead network:

1 Click the Compensator Editor tab to open the Compensator Editor
page.

2 Right-click in the Dynamics table and select Add Pole/Zero > Lead.

This figure shows the process of adding a lead network on the Compensator
Editor page.
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You can also add a lead network in the Graphical Tuning window. To add
a lead network, select Add Pole/Zero > Lead from the right-click menu.

Your cursor turns into a red x’. Left-click along the Nichols curve to add

the lead network. To move the lead network along the curve, left-click the
pole or zero and drag.

You can track the pole’s movement in the status bar at the bottom of the
Graphical Tuning window. The status bar tells you the current location of
the pole.

Using the Compensator Editor page, move the lead network pole to -28
and the zero to -4.3 for this design. The zero should be almost on top of the
right-most pole of the plant (the DC motor model). Adjust the compensator
gain to 84. This gives the final design.
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Final Nichols Plot Design for the DC Motor Compensator

The gain and phase margins are 21.9 dB and 65.7 degrees, respectively.
Inspect the closed-loop step response to see if the rise time and overshoot

requirements are met.
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Closed-Loop Step Response for the Final Compensator Design

As this figure shows, the rise time is 0.448 second, and the overshoot is a little
over 3%. This satisfies the rest of the design requirements.
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Automated Tuning Design

In this section...

“Supported Automated Tuning Methods” on page 4-93

“Loading and Displaying the DC Motor Example for Automated Tuning”
on page 4-93

“Applying Automated PID Tuning” on page 4-95

Supported Automated Tuning Methods

The SISO Design Tool simplifies the task of designing and tuning
compensators. There are five automated tuning methods in the SISO Design
Tool to help you design an initial stabilizing compensator for a SISO loop
on-the-fly or refine existing compensator design so that it satisfies a certain
user-defined design specification.

The available tuning methods are:

® Optimization-based tuning

¢ PID tuning

¢ Internal Model Control (IMC) tuning
¢ LQG synthesis

® Loop shaping

For a detailed discussion of these, see “Automated Tuning” in the Control
System ToolboxUser’s Guide.

Loading and Displaying the DC Motor Example for
Automated Tuning

Follow these steps to load and display the DC Motor example for automated
tuning:

1 If you have not yet built the DC Motor example, type

load ltiexamples
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2 To open the SISO Design Tool and import the DC motor, type
sisotool(sys_dc)

at the MATLAB prompt. This opens both the SISO Design Task node
on the Control and Estimation Tools Manager and the Graphical Tuning
window with sys_dc loaded.

3 Click the Analysis Plots tab to set the analysis plots. Select the plot type
as Step for Plot 1. Then, check the box for plot 1 to the left of Closed-Loop
r to y, as shown in the following figure, to open a linked LTI Viewer with

the closed-loop step response from reference signal r to output signal y.
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SIS0 Design Taszk Mode

4 In the LTI Viewer that appears, use the right-click menu to add rise time
and steady state values to your plot.
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Step Response When Compensator = 1
Note that by default, the compensator is 1 and unit negative feedback is used
(see Architecture in the Control System Toolbox User’s Guide). When a unit

step 1s applied to the setpoint change, the steady state value of the system
output is 0.0361, which is far from the setpoint, and its rise time is 0.589.

Applying Automated PID Tuning

1 Click the Automated Tuning tab.
2 Select PID tuning from the Design method list.

3 Leave C as the default compensator.
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E! Control and Estimation Tools Manager

File Edt Help

=10l x|

g’:ﬂ|nn

@\ Wiorkspace
=-41] SI50 Design Task
[+ - Design Histary

Architecture | Compensator Editor | Graphical Tuning | &nalysis Plots  Autamated Tuning I

Design method: =

~ Compensator

c =1

- Specifications

Controller type: (ol Pl = PID

" PID with derivative filker 1{1+s/M), M frequency: (100

Tuning algorithm: I Singular frequency based tuning LI
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You can choose from the following controller types:

o P
e PI
e PID

Designing a Proportional-Only Controller

1 For the controller type, click the P option button for proportional-only

control (C=K).

2 Select the Ziegler-Nichols open loop tuning algorithm from the
Tuning algorithm list.
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3 Click the Set-Point Tracking option button.

4 Click Update Compensator. The LTI Viewer is updated with the
application of PID automated tuning with P and the compensator value is
now 205.49.
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Note that the rise time is arrived at in just 0.0774 seconds, compared with
0.589 when C=1. However, the steady state value of 0.885 can still be
improved by setting the automated tuning controller type to PI, as described
in “Designing a Proportional-Integral Controller” on page 4-97.

Designing a Proportional-Integral Controller

1 For the controller type, click the PI option button for proportional-integral

control (C =K, +&).
s
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2 Select the Ziegler-Nichols open loop tuning algorithm from the
Tuning algorithm list.

3 Click the Set-Point Tracking option button.

4 Click Update Compensator. The LTI Viewer is updated with the
application of PID automated tuning with PI and the compensator value

. (1+0.36s)
1s now 487.64 X ——.
S
L=
File Edit ‘Window Help
D& & & E
Step Response
1.4 T T
1.2 —
T . T T
- —
® 05 ol | —
E . .
= | |
g osl | 4
| |
| |
0.4 - ' i
| |
oz|!] ! -
|
okl | L L L L L L
1] 0.2 0.4 06 05 1 1.2 1.4
Time (zec)
LTI iewer ¥ Real-Time Update

Although the rise time has increased slightly (0.0876), the steady state value
is 1. Applying automated tuning using PID tuning set to PI will guarantee
zero offset.
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Multi-Loop Compensator Design

In this section...

“When to Use Multi-Loop Compensator Design” on page 4-99
“Workflow for Multi-Loop Compensator Design” on page 4-99

“Example: Position Control of a DC Motor” on page 4-99

When to Use Multi-Loop Compensator Design

In many applications, a single-loop design is not feasible. If you have a design
with inner loops, you can use the SISO Design Tool to design a compensator
that meets your specifications.

Workflow for Multi-Loop Compensator Design

A typical procedure is to design the innermost loop on its own. You can

use the SISO Design Tool to isolate the design on individual loops. When
used this way, the tool ignores outer loop dynamics. Once the inner loop is
designed, you can move on to the design of the outer loop compensator to
achieve the desired closed-loop behavior. “Example: Position Control of a DC
Motor” on page 4-99 shows an example of this procedure.

Example: Position Control of a DC Motor

Instead of controlling the angular rate of a DC motor, this example develops a
control law for controlling the position (angle) of the motor shaft. The block
diagram of the DC motor, as shown in the following figure, has an integrator
added as an outer loop.
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Be

_]-(i)i Cl

Va

)

DC Motor

0| -

C2 |=x

Block Diagram of the Position-Controlled DC Motor

The design goal for this example is the minimize the closed-loop step response
settling time while maintaining an inner loop phase margin of at least 65°
with maximum bandwidth.

For details on how to derive state-space and transfer function representations
of a DC motor, see “SISO Example: The DC Motor” on page 2-3.

Designing a multi-loop compensator for a DC motor involves the following
steps:

® “Developing a Mathematical Model of the DC Motor” on page 4-100

® “Selecting the Architecture and Importing the Model” on page 4-102

® “Designing the Inner Loop” on page 4-105

® “Tuning the Outer Loop” on page 4-107

e “Validating the Design with the LTI Viewer for SISO Design” on page 4-109

Developing a Mathematical Model of the DC Motor
These are the relevant physical constants:

.0 % Ohms
0.5 % Henrys
Km=0.1; Kb = 0.1 % Torque and back emf constants

R=
L

| \V]
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First, construct a state-space model of the DC motor with one input, the

o°

Nms
k

g.m"2/s"2

applied voltage (Va). The output is the angular rate w.

h1i = tf(Km,[L,R]); % Armature

h2

tf(1,[J, KF]) %

dcm = ss(h2) *h1; w

Eq

dcm = feedback(dcm, Kb, 1, 1)

uation of motion
h2 cascaded with hi

;% Closes back emf loop

Adapting the Model to SISO Tool Architecture

One possible choice for your architecture is this multi-loop configuration.

—2-[Cl]-¢~G |

Comparing this architecture to the original Block Diagram of the

Position-Controlled DC Motor on page 4-100, it is evident that the two do not
match. Using block diagram algebra, you can manipulate the original figure

into one that fits this architecture.

Be

Y

C1

Fr—- - — — — 1
| Va w 1 | g

{3 DC Motor = —
I I
L. - - - — — — __ __ _

- —l—

I I

€20

I I

I I

|| S I

L —T— 41

Position-Controlled DC Motor Rearchitected
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To create this representation, add an integrator to get ®, the angular
displacement, and a pure differentiator in the inner loop’s return path. The
channel from Va to wis dcm(1), making it the appropriate channel for adding
the integrator.

G = dem*tf(1,[1,0]) % Motor with integrator; output is theta.
C2 = tf('s') % Differentiator

Selecting the Architecture and Importing the Model
Open the SISO Design Tool by typing

sisotool

at the MATLAB prompt. Once the Controls & Estimation Tools Manager
opens, click Control Architecture on the Architecture page. Select the
multi-loop configuration with two compensators, C1 in the forward path and
C2 in the inner feedback loop — located in the lower-right corner.

) Control Architecture (=] ]
Select Control Architecture: il dy

Buli-=S e wl O | wdm G !

c2

Choose this loop —m— f*"
configuration. ’ n
ﬂ-ﬁ- Signs | Blocks and Signials
Identifier Sign
52 -1

Lef ]

Ok Cancel Help

Control Architecture Window

Next, import the model parameters by clicking System Data on the
Architecture tab. This opens the System Data dialog box. Set G to G from
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the workspace. Assume a perfect sensor and set H to 1. C1 and C2 are the
gains you will use to design a compensator. Set C1 to 1 and C2 to C2 from the
workspace. Your System Data dialog box should look like this.

Impart Model

System

Data

G

H

1

c2

Ok | Cancel | Help |

Selecting SISO Design Graphical Editor Views

Once you have selected the multi-loop architecture, click the Graphical

Tuning tab. Set the plot types as follows:

1 Open-Loop 1 to "Root-Locus"

2 Open-Loop 2 to "Open-Loop Bode"

Your Graphical Tuning page should look like this.
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Architecture | Compensator Editor
Design plots configurstion

Analysis Plots | Automsted Tuning

Plat Available OpeniClosed-Loop to Tune Plat Type
Plot 1 COpen-Loop 1 || Root Locus i =
Plat 2 Open-Loop 2 || 9pen-Loop Bode 7 |
Plat 3 Open-Loop 1 ||| Mone |
Plat 4 Open-Loop 1 ||| Mone |
Plat 5 Open-Loop 1 ||| Mone | v|

Surmmary of available OpeniClosed-loops to tune:

Loop Matne: Loop Description
(Open-Loogp 1 Open-Loop - Cutput of C1
Open-Loop 2 Open-Loop - Cutput of C2

Select Newy CpeniClosed-Loop to Tune ... | Showy Design Plot |

Graphical Tuning Page Set for DC Motor Multi-Loop Design

Click Show Design Plot to see the SISO Design Graphical editor.
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-} SIS0 Design for SIS0 Design Task
File Edit ‘iew Designs Analysis Tools ‘Window Help

IS[=] E3

L xo %o @O W

Root Locus Editor for Open-Loop 1 (0L1)
15 T T T T T

Open-Loop Bode Editor for Open-Loop 2 (0L2)

G Inf
_&0 HFred: Inf
Stable loop

P Inf
Freo: Matd
0

-25 =20 -15 -10 -5
Real Lxis

10° 10°
Frequency (radizec)

Applied nevy configuration. Right-click on the plots for design options.

Designing the Inner Loop

You are now in a position to do the design. Start with the design of the inner
loop. To do this, go to the Architecture page and remove the effects of the

outer loop by following these steps:

1 Click Loop Configuration. This opens the Open-Loop Configuration

dialog box.

2 From the pull-down menu, select Open-Loop Output of C2.

3 Click Highlight feedback loop. This opens a figure of the control
architecture showing the loop configuration.
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<) Control Architecture (- [T =] I
du dy

C1 G

The outer loop < 2

is grayed out.
$ H
n

Notice how the C1 piece of the compensator and the outer loop are grayed out.
This means that they will have no effect on the inner loop at this time.

Next, turn to the SISO Design Graphical editor. Use the Bode plot for open
loop 2 (the inner loop) and increase the gain to maximize bandwidth subject to
a 65° phase margin. This turns out to be a gain of about 16.1 for C2.
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). SIS0 Design for SISO Design Task [_ O] x|
File Edit Wiew Designs Analysis Tools ‘Window Help

hxo %o @A W

Root Locus Editor for Open-Loop 1 (0L1) Open-Loop Bode Editor for Open-Loop 2 (0L2)
30 T T T T T 20
20 - ~
10 ~
G0 F G Inf
: Fredq: Inf
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o0+ i
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Real &xis Freguency (radizec)

2 gain changed to 16.1
Right-click on plots for more design options.

Setting the Inner Loop Gain

This finishes the design of the inner loop.

Tuning the Outer Loop

The goal in designing the outer loop is to minimize the settling time. Note
that the outer loop can "see" the inner loop, so that the tuning affects the

entire system. Follow these steps:

1 Go to the Analysis Plot tab in the Controls & Estimation Tools Manager.

Select the Closed-Loop r to y check box.

2 Select Step from the Plot 1 pull-down menu. This opens the LTI Viewer

for SISO Design.
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3 Right-click in the step response plot and select Characteristics>Settling
Time. Your LTI Viewer should look like this.

) LTI Yiewer for SISO Design Task (=] ]

File Edit ‘Window Help

D& &a|E

Step Response
T

Amplitude

il L L L
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Time (zec)

I
0 100 120

LTI Wiewver ¥ Real-Time Update

Initial Step Response with Settling Time
The settling time is about 79 s.

Return to the SISO Design Graphical editor and increase the gain of C1 in the
root locus plot. At a gain of about 90.2, you will see the complex pair of poles
move toward a slower time constant as the third pole moves toward a faster
one. You can view the trade-off in the LTI Viewer for SISO Design. As the
gain is changed, the closed-loop step response changes.

The 90.2 gain seems to yield a good compromise between rise and settling
time.
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;) SIS0 Design for SISO Design Task =] E3
File Edit ‘iew Designs Analysis Tools ‘Window Help
e o
f x 0 £ 3| R W
Root Locus Editor for Open-Loop 1 (0L1) Open-Loop Bode Editor for Open-Loop 2 (0L2)
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-80
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P.M.: BS deg
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Final Gain Choice for C1

Validating the Design with the LTI Viewer for SISO Design

Turning back to the LTI Viewer for SISO Design, it is evident that the settling
time is now much lower than the original 78.9 s.
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) LTI Yiewer for SISO Design Task 10l =|
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With a settling time of about 0.8 s, and a phase margin of 65° in the inner
loop, the design is complete.
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Functions for Compensator Design

In this section...

“When to Use Functions for Compensator Design” on page 4-111

“Root Locus Design” on page 4-111

“Pole Placement” on page 4-112

“Linear-Quadratic-Gaussian (LQG) Design” on page 4-115

“Example — Designing an LQG Regulator” on page 4-126

“Example — Designing an LQG Servo Controller” on page 4-129

“Example — Designing an LQR Servo Controller in Simulink” on page 4-132

When to Use Functions for Compensator Design

The term control system design refers to the process of selecting feedback
gains that meet design specifications in a closed-loop control system. Most
design methods are iterative, combining parameter selection with analysis,
simulation, and insight into the dynamics of the plant.

In addition to the SISO Design Tool, you can use functions for a broader range
of control applications, including
® (Classical SISO design

® Modern MIMO design techniques such as pole placement and linear
quadratic Gaussian (LQG) methods

Root Locus Design

The following table summarizes the functions for designing compensators
using root locus design techniques.

Function Description

pzmap Pole-zero map

rlocus Evans root locus plot

sgrid Continuous ®,,,{ grid for root locus plots
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Function Description
sisotool Root Locus Design GUI
zgrid . .
Discrete w,,,{ grid for root locus plots

4-112

Pole Placement

The closed-loop pole locations have a direct impact on time response
characteristics such as rise time, settling time, and transient oscillations.
Root locus uses compensator gains to move closed-loop poles to achieve design
specifications for SISO systems. You can, however, use state-space techniques
to assign closed-loop poles. This design technique is known as pole placement,
which differs from root locus in the following ways:

¢ Using pole placement techniques, you can design dynamic compensators.

® Pole placement techniques are applicable to MIMO systems.

Pole placement requires a state-space model of the system (use ss to convert
other model formats to state space). In continuous time, such models are of

the form
x=Ax+Bu
y=Cx+ Du

where u is the vector of control inputs, x is the state vector, and y is the vector
of measurements.

State-Feedback Gain Selection
Under state feedback u =—Kx, the closed-loop dynamics are given by

x=(A-BK)x

and the closed-loop poles are the eigenvalues of A-BK. Using the place
function, you can compute a gain matrix K that assigns these poles to any
desired locations in the complex plane (provided that (A,B) is controllable).
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For example, for state matrices A and B, and vector p that contains the desired
locations of the closed loop poles,

K = place(A,B,p);

computes an appropriate gain matrix K.

State Estimator Design

You cannot implement the state-feedback law u = —Kx unless the full state x
is measured. However, you can construct a state estimate £ such that the

law u =-K¢& retains similar pole assignment and closed-loop properties. You
can achieve this by designing a state estimator (or observer) of the form

E=A&+Bu+L(y—-CE& - Du)

The estimator poles are the eigenvalues of A-LC, which can be arbitrarily
assigned by proper selection of the estimator gain matrix L, provided that (C,
A) is observable. Generally, the estimator dynamics should be faster than the
controller dynamics (eigenvalues of A-BK).

Use the place function to calculate the L matrix

L = place(A',C',q)

where A and C are the state and output matrices, and q is the vector containing
the desired closed-loop poles for the observer.

Replacing x by its estimate £ in u =—Kx yields the dynamic output-feedback
compensator

E=[A-LC—-(B-LD)KIE + Ly
u=-KE&

Note that the resulting closed-loop dynamics are
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Hence, you actually assign all closed-loop poles by independently placing
the eigenvalues of A-BK and A-LC.

Example. Given a continuous-time state-space model
sys_pp = ss(A,B,C,D)
with seven outputs and four inputs, suppose you have designed

e A state-feedback controller gain K using inputs 1, 2, and 4 of the plant
as control inputs

® A state estimator with gain L using outputs 4, 7, and 1 of the plant as
sensors

® Input 3 of the plant as an additional known input

You can then connect the controller and estimator and form the dynamic
compensator using this code:

controls = [1,2,4];

sensors = [4,7,1];

known = [3];

regulator = reg(sys_pp,K,L,sensors,known,controls)

Pole Placement Tools
You can use functions to

¢ Compute gain matrices K and L that achieve the desired closed-loop pole
locations.

® Form the state estimator and dynamic compensator using these gains.

The following table summarizes the functions for pole placement.
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Functions Description

acker SISO pole placement

estim Form state estimator given estimator gain

place MIMO pole placement

reg Form output-feedback compensator given state-feedback
and estimator gains

The function acker is limited to SISO systems, and you should use it only for
systems with a small number of states. The function place is a more general
and numerically robust alternative to acker.

Caution

Pole placement can be badly conditioned if you choose unrealistic pole
locations. In particular, you should avoid:

¢ Placing multiple poles at the same location.

® Moving poles that are weakly controllable or observable. This typically
requires high gain, which in turn makes the entire closed-loop
eigenstructure very sensitive to perturbation.

Linear-Quadratic-Gaussian (LQG) Design

Linear-quadratic-Gaussian (LQG) control is a modern state-space technique
for designing optimal dynamic regulators and servo controllers with integral
action (also known as set point trackers). This technique allows you to trade
off regulation/tracker performance and control effort, and to take into account
process disturbances and measurement noise.

To design LQG regulators and set point trackers, you perform the following
steps:

1 Construct the LQ-optimal gain.

2 Construct a Kalman filter (state estimator).
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3 Form the LQG design by connecting the LQ-optimal gain and the Kalman
filter.

For more information about using LQG design to create LQG regulators , see
“Linear-Quadratic-Gaussian (LQG) Design for Regulation” on page 4-116.

For more information about using LQG design to create LQG servo controllers,
see “Linear-Quadratic-Gaussian (LQG) Design of Servo Controller with
Integral Action” on page 4-121.

These sections focus on the continuous-time case. For information about
discrete-time LQG design, see the d1qr and kalman reference pages.

Linear-Quadratic-Gaussian (LQG) Design for Regulation

You can design an LQG regulator to regulate the output y around zero in
the following model.

—I_:___u _____ WL v

Kalman - Plant y
y A—{ Fitter [~ K — —
_________ J
LQG Regulator

The plant in this model experiences disturbances (process noise) w and is
driven by controls u. The regulator relies on the noisy measurements y to
generate these controls. The plant state and measurement equations take the
form of

x = Ax + Bu+Gw
y=Cx+Du+Hw+v

and both w and v are modeled as white noise.
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Note LQG design requires a state-space model of the plant. You can use ss
to convert other model formats to state space.

To design LQG regulators, you can use the design techniques shown in the
following table.

To design an LQG regulator using... | Use the following commands:

A quick, one-step design technique 1qg

woheet e Delllerdony do ek For more information, see the 1qg

. . . . f .

¢ (is an identity matrix and H = 0. v e

e All known (deterministic) inputs are
control inputs and all outputs are
measured.

® Integrator states are weighted
independently of states of plants and
control inputs.

e The state estimator of the Kalman

filter is based on x[n|n-1].

A more flexible, three-step design 1qr, kalman, and lqgreg
technique that allows you to specify: For more information, see
. .
sy G el ¢ “Constructing the Optimal
® Known (deterministic) inputs that State-Feedback Gain for
are not controls and/or outputs that Regulation” on page 4-118

G 00 eseth ¢ “Constructing the Kalman

¢ A flexible weighting scheme for State Estimator” on page 4-118
integrator states, plant states, and e “Forming the LQG Regulator”
controls.

on page 4-120
e The state estimator of the Kalman

filter based on either x[n|n] or

z[n|n-1].
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Constructing the Optimal State-Feedback Gain for Regulation. You
construct the LQ-optimal gain from the following elements:

® State-space system matrices

® Weighting matrices Q, R, and N, which define the tradeoff between

regulation performance (how fast x(¢) goes to zero) and control effort.

To construct the optimal gain, type the following command:
K= 1qr(A,B,Q,R,N)

This command computes the optimal gain matrix K, for which the state

feedback law u = —Kx minimizes the following quadratic cost function for
continuous time:

Jw) = J.: {xTQx +2xT Nu+uT Ru}dt

The software computes the gain matrix K by solving an algebraic Riccati
equation.

For information about constructing LQ-optimal gain, including the cost
function that the software minimizes for discrete time, see the 1qr reference

page.

Constructing the Kalman State Estimator. You need a Kalman state
estimator for LQG regulation and servo control because you cannot implement
optimal LQ-optimal state feedback without full state measurement.

You construct the state estimate * such that u =K% remains optimal for
the output-feedback problem. You construct the Kalman state estimator gain
from the following elements:

e State-space plant model sys

¢ Noise covariance data, Qn, Rn, and Nn

The following figure shows the required dimensions for Qn, Rn, and Nn.
If Nn is O, you can omit it.
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Length [w) Length (y)

Length [y) Length [w)

Required Dimensions for Qn, Rn, and Nn

Note You construct the Kalman state estimator in the same way for both
regulation and servo control.

To construct the Kalman state estimator, type the following command:
[kest,L,P] = kalman(sys,Qn,Rn,Nn);

This command computes a Kalman state estimator, kest with the following
plant equations:

x = Ax + Bu+Gw
y=Cx+Du+Hw+v

where w and v are modeled as white noise. L is the Kalman gain and P the
covariance matrix.

The software generates this state estimate using the Kalman filter

%£=A&+Bu+L(y—Cfc—Du)

with inputs u (controls) and y (measurements). The noise covariance data

Eww")=Q, Ew")=R, Ew)=N,

determines the Kalman gain L through an algebraic Riccati equation.

The Kalman filter is an optimal estimator when dealing with Gaussian white
noise. Specifically, it minimizes the asymptotic covariance
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. . T
lim E{ix-%)x-%)")
T —soa

of the estimation error x —x .

u—— Kalman o
y — Estimator

For more information, see the kalman reference page. For a complete example
of a Kalman filter implementation, see Kalman Filtering.

Forming the LQG Regulator. To form the LQG regulator, connect the
Kalman filter kest and LQ-optimal gain K by typing the following command:

regulator = lqgreg(kest, K);

This command forms the LQG regulator shown in the following figure.

|
| |
| |
y || kest »| -K | _
| | u
L e J
LQG Regulator

The regulator has the following state-space equations:

%&=[A—LC—(B—LD)K]§¢+Ly

u=-Kx

For more information on forming LQG regulators, see the 1qgreg reference
page and LQG Regulation: Rolling Mill Example.



Functions for Compensator Design

Linear-Quadratic-Gaussian (LQG) Design of Servo Controller
with Integral Action
You can design a servo controller with integral action for the following model:

v

V.,
> kest ’A‘_L,
| [
X;

\
\
\
\
\
\
r—&—(f)_—» Integrator
\

LQG Servo Controller

\
\
\
1 Plant —
\
\
\
\

The servo controller you design ensures that the output y tracks the reference
command r while rejecting process disturbances w and measurement noise v.

The plant in the previous figure is subject to disturbances w and is driven by
controls u. The servo controller relies on the noisy measurements y to generate

these controls. The plant state and measurement equations are of the form

x=Ax+ Bu+Guw
y=Cx+Du+Hw+v

and both w and v are modeled as white noise.

Note LQG design requires a state-space model of the plant. You can use ss
to convert other model formats to state space.

To design LLQG servo controllers, you can use the design techniques shown
in the following table.
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To design an LQG servo controller | Use the following commands:
using...

A quick, one-step design technique 1qg

vkt whis dolllesdong s et For more information, see the 1qg

. . . . f .

¢ (is an identity matrix and H = 0. SR e

e All known (deterministic) inputs are
control inputs and all outputs are
measured.

¢ Integrator states are weighted
independently of states of plants and
control inputs.

e The state estimator of the Kalman

filter is based on x[n|n-1].

A more flexible, three-step design 1qi, kalman, and lqgtrack
technique that allows you to specify: For more information, see
. .
iy (6 ol {2 ® “Constructing the Optimal
¢ Known (deterministic) inputs that State-Feedback Gain for Servo
are not controls and/or outputs that Control” on page 4-122

Splag ¢ “Constructing the Kalman

* A flexible weighting scheme for State Estimator” on page 4-123
integrator states, plant states, and e “Forming the LQG Servo
controls.

Control” on page 4-125
® The state estimator of the Kalman

filter based on either %[n|n] or

z[n|n-1].

Constructing the Optimal State-Feedback Gain for Servo Control. You
construct the LQ-optimal gain from the

e State-space plant model sys

¢ Weighting matrices Q, R, and N, which define the tradeoff between tracker
performance and control effort
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To construct the optimal gain, type the following command:
K= 1lgi(sys,Q,R,N)

This command computes the optimal gain matrix K, for which the state

feedback law u = —-Kz = —K|[x;x;] minimizes the following quadratic cost
function for continuous time:

Jw) = j:{zTQz +ul Ru+ 22TNu}dt

The software computes the gain matrix K by solving an algebraic Riccati
equation.

For information about constructing LQ-optimal gain, including the cost
function that the software minimizes for discrete time, see the 1qi reference

page.

Constructing the Kalman State Estimator. You need a Kalman state
estimator for LQG regulation and servo control because you cannot implement
LQ-optimal state feedback without full state measurement.

You construct the state estimate * such that u = —K# remains optimal for
the output-feedback problem. You construct the Kalman state estimator gain
from the following elements:

e State-space plant model sys

* Noise covariance data, Qn, Rn, and Nn

The following figure shows the required dimensions for Qn, Rn, and Nn.
If Nn is O, you can omit it.
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Length [w) Length (y)

Length [y) Length [w)

Required Dimensions for Qn, Rn, and Nn

Note You construct the Kalman state estimator in the same way for both
regulation and servo control.

To construct the Kalman state estimator, type the following command:
[kest,L,P] = kalman(sys,Qn,Rn,Nn);

This command computes a Kalman state estimator, kest with the following
plant equations:

x = Ax + Bu+Gw
y=Cx+Du+Hw+v

where w and v are modeled as white noise. L is the Kalman gain and P the
covariance matrix.

The software generates this state estimate using the Kalman filter

%£=A&+Bu+L(y—Cfc—Du)

with inputs u (controls) and y (measurements). The noise covariance data

Eww")=Q, Ew")=R, Ew)=N,

determines the Kalman gain L through an algebraic Riccati equation.

The Kalman filter is an optimal estimator when dealing with Gaussian white
noise. Specifically, it minimizes the asymptotic covariance
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. . T
lim E{ix-%)x-%)")
T —soa

of the estimation error x —x .

u—— Kalman o
y — Estimator

For more information, see the kalman reference page. For a complete example
of a Kalman filter implementation, see Kalman Filtering.

Forming the LQG Servo Control. To form a two-degree-of-freedom LQG
servo controller, connect the Kalman filter kest and LQ-optimal gain K by

typing the following command:

servocontroller = lqgtrack(kest, K);

This command forms the LQG servo controller shown in the following figure.

> kest

\
\
\
\
\
\
r —0——/10—> Integrator
\
y—t

LQG Servo Controller

The servo controller has the following state-space equations:
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X;
X
u=[-K, _Ki]|:x

i

[&]:{A—BKx—§C+LDKx —BKL-+LDKL~][£}+{0 L:|[r]

0 X; I -1 y

For more information on forming LQG servo controllers, including how
to form a one-degree-of-freedom LQG servo controller, see the 1qgtrack

reference page.

Example — Designing an LQG Regulator

As an example of LQG design, consider the following regulation problem.

LQG Regulator

d
y
y .| F(s) é) = Plant T .

The goal is to regulate the plant output y around zero. The input disturbance
d is low frequency with power spectral density (PSD) concentrated below

10 rad/s. For LQG design purposes, it is modeled as white noise driving a
lowpass filter with a cutoff at 10 rad/s, shown in the following figure.

10

w (white noise) |—»

s+10

— d (colored noise)

For simplicity, this noise is modeled as Gaussian white noise with variance

of 1.

The following figure shows the Bode magnitude of the shaping filter.
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# Figure No_ 1 [H[=] E3
File Edit ¥iew Insert Tools Window Help

Deda "A A/ | @20
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Bode Magnitude of the Lowpass Filter

There is some measurement noise n, with noise intensity given by
E(n?)=0.01
Use the cost function

J(w) = j: 10y? +u2)dt

to specify the tradeoff between regulation performance and cost of control.
The following equations represent an open-loop state-space model:

x=Ax+ Bu+ Bd (stateequations)
y=Cx+n (measurements)

where (A,B,(C) is a state-space realization of 100 /(% +5+100).
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The following commands design the optimal LQG regulator F(s) for this
problem:

sys = ss(tf(100,[1 1 100])) % State-space plant model

% Design LQ-optimal gain K

K = 1qry(sys,10,1) % u = -Kx minimizes J(u)
% Separate control input u and disturbance input d
P = sys(:,[1 1]);

o°

input [u;d], output y

% Design Kalman state estimator Kest.
Kest = kalman(P,1,0.01)

% Form LQG regulator = LQ gain + Kalman filter.
F = lggreg(Kest,K)

These commands returns a state-space model F of the LQG regulator F(s).
The 1qry, kalman, and lqgreg functions perform discrete-time LQG design
when you apply them to discrete plants.

To validate the design, close the loop with feedback, create and add the
lowpass filter in series with the closed-loop system, and compare the open-
and closed-loop impulse responses by using the impulse function.

% Close loop
clsys = feedback(sys,F,+1)
% Note positive feedback.

% Create the lowpass filter and add it in series with clsys.
s = tf('s");

1pf= 10/(s+10) ;

clsys_fin = lpf*clsys;

% Open- vs. closed-loop impulse responses
impulse(sys, 'r--',clsys_fin, 'b-")

These commands produce the following figure, which compares the open- and
closed-loop impulse responses for this example.

4-128



Functions for Compensator Design
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Comparison of Open- and Closed-Loop Impulse Response

Example — Designing an LQG Servo Controller

This example shows you how to design a servo controller for the following
system.

"4
WL
r o |
| y
\ trksys | u Plant —O—1—
f——— |

LQG Servo Controller
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The plant has two states (x), two control inputs (), two random inputs (w),
one output (y), measurement noise for the output (v), and the following state
and measurement equations:

x =Ax+ Bu+Guw
y=Cx+ Du+Hw+v

where
010 03 1 -0.7 1.12
A=(0 0 1 B=| 0 1 G=1-117 1
1 00 -0.3 0.9 014 15

C=[19 1.3 1] D=[053 -0.61] H=[-1.2 -0.89]

The system has the following noise covariance data:

21
Rn = E(va) =0.7

Q, = Eww?) ={4 2}

Use the following cost function to define the tradeoff between tracker
performance and control effort:

o0 10
J () :jo {0.1xTx+xi2 +ul [0 2]u}7t

To design an LQG servo controller for this system:

1 Create the state space system by typing the following in the MATLAB
Command Window:

A=1[010;001;100];

B =[0.3 1;0 1;-0.3 0.9];
G=1[-0.71.12; -1.17 1; .14 1.5];
C=1[1.91.3 1];

D = [0.53 -0.61];
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H=1[-1.2 -0.89];
sys = ss(A,[B G],C,[D H]);

2 Construct the optimal state-feedback gain using the given cost function
by typing the following commands:

nx = 3; %sNumber of states

ny = 1; %SNumber of outputs

Q = blkdiag(0.1*eye(nx),eye(ny));
R =1[10;0 2];

K = lgi(ss(A,B,C,D),Q,R);

3 Construct the Kalman state estimator using the given noise covariance
data by typing the following commands:

Qn [4 2;2 1];
Rn = 0.7;
kest = kalman(sys,Qn,Rn);

4 Connect the Kalman state estimator and the optimal state-feedback gain to
form the LQG servo controller by typing the following command:

trksys = lggtrack(kest,K)

This command returns the following LQG servo controller:

>> trksys = lqgtrack(kest,K)

a:
x1_e X2_e x3_e xi1
x1_e -2.373 -1.062 -1.649 0.772
x2_e -3.443 -2.876 -1.335 0.6351
x3_e -1.963 -2.483 -2.043 0.4049
x1i1 0 0 0 0
b =
ri y1
x1_e 0 0.2849
X2_e 0 0.7727
x3_e 0 0.7058
x1i1 1 -1
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C:
x1_e X2_e x3_e xi1
ul -0.5388 -0.4173 -0.2481 0.5578
u2 -1.492 -1.388 -1.131 0.5869
d =
r1 yi
ui
uz 0 O

Input groups:

Name Channels
Setpoint 1
Measurement 2

Output groups:
Name Channels
Controls 1,2

Continuous-time model.

Example — Designing an LQR Servo Controller in
Simulink

The following figure shows a Simulink® block diagram shows a tracking
problem in aircraft autopilot design. To open this diagram, type 1qrpilot at
the MATLAB prompt.
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E!Iqrpik}t — 5 LI
File Edit View Simulaton Format Tools Help
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— (pitch angle)
phi_ref
¥
1d2d
¥ Linearized rageasg
Integrator Dynamics LI v i
Nonlinesr Mogel (roll angle)
state vector
roll angle phi
Ready [100% [ |ode4s v

Key features of this diagram to note are the following:

¢ The Linearized Dynamics block contains the linearized airframe.

e sf _aerodyn is an S-Function block that contains the nonlinear equations

for (0,¢)=(0,15").

® The error signal between ¢ and the ¢,.r is passed through an integrator.
This aids in driving the error to zero.

State-Space Equations for an Airframe
Beginning with the standard state-space equation

x =Ax+ Bu
where

X = [u’v7w’p’q7r’0’¢]T
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The variables u, v, and w are the three velocities with respect to the body
frame, shown as follows.

i

Body Coordinate Frame for an Aircraft

The variables ¢ and 6 are roll and pitch, and p, q, and r are the roll, pitch,
and yaw rates, respectively.

The airframe dynamics are nonlinear. The following equation shows the
nonlinear components added to the state space equation.

—gsin6
gcos0sin ¢
gcosBcosd

0

0

0
gcosh—rsing

x=Ax+Bu+

| (gsind+rcosd)-tan® |
Nonlinear Component of the State-Space Equation

To see the numerical values for A and B, type

load 1lgrpilot
A, B

at the MATLAB prompt.
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Trimming

For LQG design purposes, the nonlinear dynamics are trimmed at ¢ =15°

and p, q, r, and 6 set to zero. Since u, v, and w do not enter into the
nonlinear term in the preceding figure, this amounts to linearizing around

(0,¢) =(0,15°) with all remaining states set to zero. The resulting state
matrix of the linearized model is called A15.

Problem Definition
The goal to perform a steady coordinated turn, as shown in this figure.

Aircraft Making a 60° Turn
To achieve this goal, you must design a controller that commands a steady

turn by going through a 60° roll. In addition, assume that &, the pitch angle,
1s required to stay as close to zero as possible.

Results
To calculate the LQG gain matrix, K, type

lgrdes

at the MATLAB prompt. Then, start the 1qrpilot model with the nonlinear
model, sf_aerodyn, selected.

This figure shows the response of ¢ to the 60° step command.
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# phi (roll angle)

lopp BB

Tracking the Roll Step Command
As you can see, the system tracks the commanded 60° roll in about 60 seconds.

Another goal was to keep B, the pitch angle, relatively small. This figure
shows how well the LQG controller did.

# theta (pitch angle) IH[=] E3

lprr ABEBS

Minimizing the Displacement in the Pitch Angle, Theta

Finally, this figure shows the control inputs.
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# | Control Inputs

lprr ABBS

Control Inputs for the LQG Tracking Problem

Try adjusting the Q and R matrices in 1qrdes.m and inspecting the control
inputs and the system states, making sure to rerun lqrdes to update the LQG
gain matrix K. Through trial and error, you may improve the response time of
this design. Also, compare the linear and nonlinear designs to see the effects
of the nonlinearities on the system performance.
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Learning More

¢ “Locating Demos” on page 5-2
e “Online Help” on page 5-3
e “Setting Plot Preferences and Properties” on page 5-4

® “Online Resources” on page 5-6



5 Learning More

Locating Demos
To see more examples of the Control System Toolbox software, type
demo
at the MATLAB prompt. This opens the Demo pane in the Help browser.
Select Control System Toolbox under Toolboxes to list the available

demos.

Alternatively, if you have the Help browser open, you can access the Demo
pane directly and follow the same procedure.
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Online Help

For a more detailed explanation of any of the topics covered in this book, see
the Control System Toolbox documentation in the Help Browser.

The Help Navigator supports string searches. You can specify strings and the
online manuals that you want to search. To begin a search, click the Search
tab. There is also an index available; click the Index tab to view it.
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Setting Plot Preferences and Properties

You can use three graphical user interfaces (GUIs) to control over the
visualization of time and frequency plots generated by the toolbox:

® Toolbox Preferences
® Tool Preferences

® Plot Properties

Preferences refer to global options that you can save from session to session
or to any LTI Viewer or SISO Design Tool that you open during a single
session. Properties are options that apply only to the current window. This
section gives an overview of the three GUIs; see the online help system for
complete descriptions.

Although you can set plot properties in any response plot, you can use the
Toolbox Preferences Editor to set properties for any response plot that you
generate. This figure shows the inheritance hierarchy from toolbox preference
to plot properties.

Toolbox Preferences

Persist ocross sessions
s Saved
Inheritance Eser Preferencea to disk

_TDJPrB’rBr;ms_ ¥ 1 T T T _’7/_ - X_ T Not suved
Specific fo n insfance to disk

of otoul - .
i LTI Viewer
Inheriioncs @ISD Design To@

Not soved

Plot Properties o ik

jfic to mn instonce

a ot
HResponse Flot l Hesponse Flot }

Preference and Property Inheritance Hierarchy

HResponse Flot

You can activate preference and plot editors by doing the following:



Setting Plot Preferences and Properties

® Toolbox preferences — Select Toolbox Preferences under File in either
the LTI Viewer or the SISO Design Tool.

® Tool preferences — Select SISO Tool Preferences under Edit for the
SISO Design Tool and Viewer Preferences under Edit in the LTI Viewer.

® Plot properties — Double-click any Control System Toolbox response plot
or select Properties from the right-click menus.

For a complete discussion of how to use property and preference editors, see
Customization.
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Online Resources

For the very latest information about Control System Toolbox software and
other products from The MathWorks, point your Web browser to

www.mathworks.com

and use your Internet news reader to access the newsgroup

comp.soft-sys.matlab

Many books that use MATLAB software and Control System Toolbox
software to explain control engineering concepts are available from different
publishers. A booklet titled MATLAB Based Books is available from The
MathWorks and an up-to-date list is available on the Web site.
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